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1 OpenJUMP 1.2 Tutorial (Grundlagen)

1 Vor dem groRen Sprung

OpenJUMP ist ein Geografisches Informationssystem, das urspriinglich von den kanadischen Firmen
Vivid Solutions und Refractions Research unter dem Namen JUMP entwickelt wurde. Der Name JUMP ist
die Abkiirzung fir Unified Mapping Platform, das ,J deutet auf die zugrunde liegende Programmiersprache
~Java“ hin. Das ,Open“ steht fur ,Open Source“ (Quelloffen), was bedeutet, dass der Quellcode des
Programms jedermann zugéanglich ist. OpenJUMP unterliegt der GNU General Public License und wird
heute von Programmierern weltweit gepflegt und weiterentwickelt.

Die besonderen Merkmale von OpenJUMP sind:
« Vektor-basiertes GIS.
« Unterliegt der GNU General Public License http://www.gnu.org/licenses/licenses.htmI#GPL
- Basiert auf Open GIS Standards http://www.opengeospatial.org/
« In Java geschrieben; Quelloffen (Open Source).
«  Durch so genannte Pluglns erweiterbar.
- Einfach zu bedienende Editier- und Analyse-Funktionen.

« Unterstutzt mehrere Sprachen (Englisch, Franzdsisch, Portugiesisch, Spanisch, Deutsch).

Hier wird die englischsprachige Version vorgestellt, um einen leichteren Einstieg in ergénzende
englischsprachige Literatur zu erhalten.

Die hier gezeigten Beispiele beziehen sich auf eine kleine, kiinstliche Stadt GeoCity, die am Schreibtisch
entstanden ist (incl. Orthofoto, S. 27). Auch die Namen der Eigentimer der Gebdude und der Grundstiicke

sind frei erfunden und unterliegen nicht dem Datenschutz ;-)

&= OpenJump
File Edit View Layer Tools Customize Window Help

Jo [ @ Qale= @ bxee @ m = =i
¥ GeoCity & : : i S
|Besciwelumg |
i gw?ﬂ‘:}wme || Sy
7 [ Verkehs |
'. W Attribustes: Landwirtschaft o @

1 Landwirtschaft (6 Features) i
¢ ] Topo FID |Nutzungsart |Flaeche |Ertrag ;) Srintpad.. 7/ 4
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# (=] Geba @)/18] 973 Getreide gas2 s | M & e stg\ =
HB]| 980 Acker 11379 25 L8 < 5 7 G \
m| o] 981 Graniahd 20895 40 w“ L Y Options...
W e FimkR p & L Getreide v/ . . iy
] Funke | + i SR / "
| (vl Bauernhol | ' —— Pam!? J
¢ [ Grundstuecke | ! ) %"\:3 Flipidgasta. : e i
(v Wohngebiet | ' __‘in S U :
| Stadtpark = —// IR \ =
o = v|Landwirtschaft =l o/ ‘ﬂ'm e . A
[ [¥] Gewerbegebiet o @ _ ol —
(EE e ® &§ u—,
I [V Feuchtbiotop — .
7 ] Abwasser mil 5 -
| AbwasserZufluss |
__| AbwasserAbfluss

§ [ HifsPunkte | it SR N

J00:00:01 (GeoCity.jmp) |60 MB Committed Me... | 64323.9, 51865.7)

GeoCity in OpenJUMP.
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2 Die Anzeige-Komponenten von OpenJUMP

Nach dem Start von OpenJUMP erscheint die OpenJUMP Workbench mit einem leeren Projektfenster. Das
Projektfenster ist aufgeteilt in eine Layer-Ubersicht (Layer List) und ein grafisches Fenster (Layer View), in
dem die Layer dargestellt werden. Layer (S. 21) sind Ebenen zur Darstellung von geografischen Objekten
(Features). Ein Layer stellt im Allgemeinen ein spezielles geografisches Thema dar (z.B. Gewésser, Walder,
Hauser, Bdden).

Workbench Projektfenster Grafisches Fenster

Layer-Ubersicht Werkzeugleiste

CEX

File Edit View |Layer Jools Customize Window Help

e 'QQ"? Q = 200m
V p[DiEﬂ 1 =k TECELE = ‘ FERFEE i + i i u' B‘ m

] Working

] System

[ [17 M8 Committed Me... | 450, 335) —— Statuszeile

Nach dem Start von OpenJUMP.

Ein Projekt (S. 33) ist die Zusammenfassung aller Layer. Es kénnen mehrere Projektfenster gedffnet sein.
Uber den Meniipunkt Window kann zwischen den einzelnen Fenstern gewechselt werden.

Ein neues Projekt wird Uber File>New>New Project (S. 33) erstellt.

Ein bestehendes Projekt wird Gber File>OpenProject (S. 35) gedffnet.

Achtung:

Jeder Layer muss in einer Datei oder Datenbank gesichert werden, erst dann kann das Projekt gesichert
werden (siehe Kategorien und Layer, S. 21 oderAnbindung an eine PostgreSQL/PostGIS Datenbank,
S. 63).

HCU Hamburg, Department Geomatik 7



2 OpenJUMP 1.2 Tutorial (Grundlagen)
2.1 Die Werkzeugleiste

Uber die Werkzeugleiste (Tool Bar) kénnen Funktionen wie Zoom, Pan oder der Grafische Editor
angesprochen werden.

@ e O 1 200m

Werkzeugleiste (Tool Bar)

' |.__d' Neues Projekt

Q Zoom

@ Gesamtansicht

Offnen von Projekten und Dateien

e

Pan
Zoom auf markierte Items

Q Zoom dynamisch Zoom auf Auswahlrahmen

8 2 B 3

¢= Anzeige zuriick Anzeige vor

n
n
o

_ Layerdarstellung &ndern Attribute anzeigen und adndern

Dg Markieren/Auswahlen Markierung aufheben

@ Auswahlrahmen ziehen

lﬁ_ Editor

Feature-Informationen

Messen

3 B o R

P Ruckgangig Wiederherstellen

O Ausgabefenster

{2 1 200m SchnellZoom
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Geometrien 3

3 Geometrien

3.1 Allgemeines

Ein wesentlicher Bestandteil eines GIS sind die Geometriedaten und die Sachdaten. Die Frage ist, wie wir
diese Daten in unser Projekt bekommen. Es gibt verschiedene Methoden, Geometriedaten in ein Projekt zu
integrieren:

1. Durch ,freies Zeichnen“ mit dem Grafischen Editor. Dies ist eine sehr einfache Methode und
entspricht sicherlich nicht der géngigen Praxis (siehe ,,Der grafische Editor“, S. 11)

2. Durch Import von Dateien, die in einem bestimmten Format beschrieben sind. OpenJUMP
unterstitzt in der Grundversion folgende Formate:
a) Das JUMP GML Format (.jml), welches ein vereinfachtes GML-Format ist.
b) Das GML 2.0 Format.
c) Das WKT (Well Known Text) Format.
d) ESRI Shapefile.

3. Durch Digitalisierung von Rasterdaten, die direkt eingelesen werden kénnen, oder die ein WMS-
Server liefert.

4. Durch Laden einer Datenbanktabelle im PostGIS Format (nur mit Hilfe eines Plugins, S. 63). Hierbei
werden die Daten (Geometrie- und Sachdaten) in der Objektrelationalen Datenbank PostgreSQL mit
einer PostGIS Erweiterung abgelegt und kénnen in OpendJUMP dargestellt werden.

& OpenJUMP
File Edit View Layer Tools Customize Window Help
W [ @R e @E b ¥ @0 A = we O ———0—sum

¥ “GeoCity G
* D\fenm_ﬂm I
B [ Baeume

¢ [ Verkehr
@[] HafenStrasse
B []strassen
& ] Topographie
7 [ Gebaeude
v GebaeudePrivat
B [v] GebaeudeGewerb|
B [ | Funkh
2 [] Funk8
B [v| Bauernhof
¢ [ Grundstuecke
| wohngebiet
[ Stadtpark
o []Landwirtschaft
[0 || Gewerbegebiet
=[] Feuchtbiotop
o [ Abwasser
¢ ] HiltsPunkte
B [ |HP_Achsen
B [ |HP_Gebaeude
B [ HP_Grundstuecke
E [ HP_Teich
¢ [ Raster
[} onhoFoteic -

0

E:lnlm Selected: 00, 0] 0 pts fi1 ME Committed Me... I iﬂQ'?B. 51791.3)

Digitalisierte Gebdude auf Rasterkarte (hier Orthofoto).
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3 OpenJUMP 1.2 Tutorial (Grundlagen)

OpenJUMP verfiigt Uber einen einfachen grafischen Editor, mit dem man die Geometrien (rdumliche Attribute)
von geografischen Objekten (Features) eingeben und editieren kann. Es kdénnen die Geometrien Punkt
(Point), Linienzug (Linestring) und Flache (Polygon) erstellt und bearbeitet werden.

Der grafische Editor wird mit dem Knopf @(Editing Toolbox) aus der Werkzeugleiste (Tool Bar) aufgerufen.
Features werden auf einem Layer (S. 21) dargestellt, der mit Layer>Add A New Layer erzeugt wird.
Natirlich kann auch auf bestehenden Layern gezeichnet werden, wenn sie editierbar (editable) sind.

File Edit View |Layer Tools Customize Window Help

i o Qg4 AddANew Layer 10 A 0| s L——— 200m
Add Layer... -
¥ Project 1 RunD s L
¥ (5 Working Add MiSID Layer
il Add a WMS Query...
(= System Add Image Layer (Test, ECWDLLs deactivated.)...
Add A New Category
Cut Selected Layers
Copy Selected Layers
aste Loyers
| % Remove SeiectedLayers | 2010 a

Oplions...

e locted Calegoties
Change SRID...

Rename Selected Layer...
Add new raster layer

[ [1o mB Committed Me... | f24,347)

Einen neuen Layer hinzufiigen.

Der neue Layer erhalt den Namen New und ist editierbar (editable). Ist ein Layer editierbar, so wird der
Layername rot dargestellt. Wird ein editierbarer Layer mit Linksklick markiert, erscheint der Name gelb und
man kann auf ihm zeichnen oder bestehende Geometrien verdndern. Mit dem MenlUpunkt Editable
(Rechtsklick auf den Layernamen) kann der Editierstatus eines Layers gedndert werden. Durch Links-
Doppelklick auf den Layernamen kann dieser umbenannt werden.

10 HCU Hamburg, Department Geomatik



Geometrien

3.2 Der grafische Editor (Editing Toolbox)

Die Editing Toolbox stellt Werkzeuge zur Bearbeitung von Geometrien zur Verfligung:

RTINS
A R 7
ualhe bl =
an Ak 8582
R G L
@00

Options...

Editing Toolbox.

Markieren und Verschieben

Rechteck, Polygon, Linienzug und Punkt zeichnen

Knoten einfligen, I6schen und verschieben; Item scalieren
Knoten zusammenfassen; Linienzug teilen

Polygon, Linienzug, Kreis und Bogen unter Bedingungen zeichnen

Knoten nach Lange und Winkel verschieben; Drehung; 1 Item wéhlen; Kreis mit Radius und Auflésung

3.2.1 Optionen (Snap/Grid)

Unter Options... kann unter anderem der Fangmodus (Snapping) und Gitterlinien (Grid Display) eingestellt

werden.

Voreingestellt ist ein Fangradius von 10 Pixeln und Snap to vertices (Auf Knoten fangen).

rSnapping
[¥] Snap to vertices

|| Snap to grid

~Grid Display
[v] Show grid. Size:
) Show grid as dots

® Show grid as lines

( 3% Snap Vertices Tools | Skins |
Constraints | Snap/Grid | View /Edt |

Tolerance: | 10| pixels

|| Snap to vertices and lines

Tolerance: Fangradius in Pixel
Snap to vertices: Auf Knoten fangen
Snap to vertices and lines: Auf Knoten oder Linie fangen

Snap to grid: Auf Punkte vom Gitternetz (grid) fangen

Show grid: Gitternetz ein/aus
20.0/ model units Size: Gitterabstand in Modelleinheiten
Show grid as dots: Gitternetz als Punkte darstellen

Show grid as lines: Gitternetz als Linien darstellen

Cancel

Fang- und Gitteroptionen.

HCU Hamburg, Department Geomatik 11



3

3.2.2 Optionen (Constraints)

OpenJUMP 1.2 Tutorial (Grundlagen)

Unter der Option Constraints (Bedingung, Einschréankung, Zwang) kénnen die Bedingungen festgelegt

werden, unter denen die Features gezeichnet werden kdénnen. Hierzu missen die entsprechenden Funktionen

unter Bedingungen aus der Editing Tollbox angewahlt werden (vorletzte und letzte Zeile; S. 16).

[v] Constrain length to nearest | 100.0/ model units

Incremental Angle (Shift to activate; Ctrl to close)
[#] Constrain angle by steps of 36.0 degree

by dividing 360 degreesinto: | 10 parts

Angle (Shift to activate)
| 30.@! degrees

{® Constrain to relative angle b

[v] Constrain to angle

= + -
() Constrain to absolute angle
—ﬂ

| Cancel |

Lo

& Options E|
34 Snop Vertices Tools | Skins |
Constraints |  Snap /Grid ] View / Edit
Length

Bedingungs-Optionen.

3.2.3 Optionen (View / Edit)

Length: Festgelegte Seitenldnge in Modelleinheiten

(oder ein Vielfaches davon)

Incremental Angle: Winkelintervall (mit Shift aktivieren)

Angle: Fester Winkel relativ oder absolut

(mit Shift aktivieren)

Unter der Option View / Edit kann eingestellt werden, ob wédhren des Digitalisierens auf giltige Geometrien

gepruft werden soll. Es wird dann z.B. geprift, ob die Geometrie sich selbst liberschneidet (Self-intersection)

und das Feature wird nicht gezeichnet, wenn keine gliltige Geometrie vorliegt.

- Options @
(3% Snap Vertices Tools | Skins |
_i Constraints [ Snap / Grid View / Edit

[v] Prevent edits resulting in invalid geometries

0K I'. cancel |

View / Edit Option.

12

SSelf-intersection

Number Selected: 0

Fehlerhafte Geometrie (kein gliltiges Polygon).

HCU Hamburg, Department Geomatik



Geometrien 3

3.3 Features zeichnen

Features sind abstrahierte Objekte der realen Welt. Zum Beispiel werden Straf3en als Linienziige, Gebdude
als Flachen oder Badume als Punkte abstrahiert und dargestellt.

In OpenJUMP hat jedes Feature ein rdumliches Attribut (Geometrie) und kein oder mehrere nicht-rdumliche
Attribute (non-spatial attributs, Fachdaten, Sachdaten) z.B. Strallenname, Eigentimer, Baumhd&he.

Es koénnen drei verschiedene Features gezeichnet werden:

7 Punkt (Point), | & |Linienzug (Linestring) und 2 ¥ Flache (Polygon)

Nach Auswahl des Geometrietyps wird mit Linksklick die Grafik gezeichnet. Linienziige und Fldchen werden

mit einem Doppel-Linksklick beendet.

3.3.1 Punkt (Point) #

« Neuen Layer erstellen oder bestehenden Layer markieren und editierbar machen.
Die Editing Toolbox aufrufen.

« | Draw Point Tool driicken.

« Mit Linksklick Punkte im Grafikfenster zeichnen.

3.3.2 Linienzug (Linestring) X

« Neuen Layer erstellen oder bestehenden Layer markieren und editierbar machen.
. Die Editing Toolbox aufrufen.

. R Draw Linestring driicken.

« Mit Linksklick Linienzug zeichnen.

« Mit Doppel-Linksklick beenden.

3.3.3 Flache (Polygon) &

* Neuen Layer erstellen oder bestehenden Layer markieren und editierbar machen.
_@ Die Editing Toolbox aufrufen.
. 24 Draw Polygon Tool driicken.

« Den Anfangspunkt mit Linksklick im Grafikfenster markieren.
«  Weitere Punkte mit Linksklick hinzuftigen.
« Mit Doppel-Linksklick beenden.

HCU Hamburg, Department Geomatik 13



3.34

Zeichnen eines ,Lochs* in einem Polygon

« Layer markieren und editierbar machen.

e b e Laer Joon Comsmrs Wien ot

OpenJUMP 1.2 Tutorial (Grundlagen)

@ Ale-gH L a0 A = (=]

. Q‘ Bestehendes Polygon selektieren.
. @ Editing Toolbox aufrufen.

+ B4 Polygon bzw. Loch zeichnen.
. [:3| Select Features Tool aufrufen.

ik
B
%8 |
e
W
L0 Y

L=

B s
WHxE o

« AuBerhalb des Polygons ins Grafikfenster klicken,
damit die Markierung aufgehoben wird.

s o 8 g ot A, |

Polygon mit ,Loch*.

Es ist sinnvoll, jeden Geometrietyp (Point, Linestring, Polygon) auf einem extra Layer zu zeichnen (siehe auch
Layerbearbeitung, S. 21). Jeder Layer bekommt eine vom Programm zugewiesene Farbe, die mit Change

Styles @ geandert werden kann (siehe auch Layerdarstellung (Styles), S. 39).

14

File Edit View Layer Tools Customize Window Help

QN @A e QE R 90 & @ «w

50m

b ‘Projectt
¢ [ Working
B ¥ Punkte
= v Linien
[¥] Palygone
v| PolygonMitLoch
[ System

Number Selected: 00, 0]0pts  [22 MB Committed Me... | [3565490.83, 5950721.69)

Punkte, Linieziige und Polygone auf unterschiedlichen Layern.
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Geometrien

3.3.5 Kreis mit Radius und Genauigkeit zeichnen &,

Mit der Funktion Draw circle with given radius and center kann ein Kreis mit vorher eingestelltem Radius

und Genauigkeit (Accuracy) gezeichnet werden. Hierbei kann der Mittelpunkt auf einen anderen Punkt

gefangen werden. Der Radius und die Genauigkeit kann durch Doppelklick auf den Knopf _G’;R eingestellt

werden. Je kleiner die Zahl bei Circle Accuracy ist, desto genauer wird der Kreis gezeichnet.

28 Draw circle with given radius and center. @

Draws a circle by Cirlce Radius: 50,0
specifying the radius - [
ardila chela Circle Accuracy 10.0|
accuracy and the
centre position by
mouse click.
| oK
Einstellungen durch Doppelklick auf @?;R

Hinweis: Das Zeichnen der Kreise wird hier nicht durch Doppelklick beendet, sondern durch Auswahl einer

Funktion aus der Editing Toolbox!

HCU Hamburg, Department Geomatik

15



3 OpenJUMP 1.2 Tutorial (Grundlagen)

3.4 Features unter Bedingungen (Constraints) zeichnen ’% L1

Flachen (Polygon), Linienziige (LineString), Kreise (Circle) und Bégen (Arc), kénnen unter Bedingungen
(Constraints) gezeichnet werden (z.B. festgelegte Seitenldnge oder Winkelintervalle).

Die Bedingungen werden in der Editing Toolbox @ unter Options>Constraints festgelegt (siehe auch
Optionen (Constraints), S. 12).

Im linken Bereich der Statuszeile der Workbench

(untere Zeile des OpenJUMP Fensters) lauft die

Lange und der Winkel beim Zeichnen mit.

hength: 10.0; angle: 65.12 degrees

Lange und Winkel laufen mit.

3.4.1 Constraints>Length

Hierbei kann eine feste Lange in Zeicheneinheiten festgelegt werden. Ist z.B. eine Zeicheneinheit = 1 m, so
werden nach der unteren Einstellung z.B. Linienziige mit 10 m Seitenldnge gezeichnet.
* Lange in Zeicheneinheiten (model units) festlegen. §w-Fee

. [‘2, Draw Constrained LineString wahlen. | ¥ Snap Vertices Tools | Skins |
Constraints | Snap/Grid | View/Edit |
Length

[v| Constrain length to nearest | 10.0| model units

«  Linienzug zeichnen. |
Hinweis: Funktioniert auch fir
Constrained Polygon,

Constrained Circle und Constrained Arc. Lénge in Zeicheneinheiten festlegen.

3.4.2 Constraints>Incremental Angle

Sollen z.B. rechwinklige Polygone gezeichnet werden (z.B. Digitalisierung von Geb&uden), muss die
Schrittweite des Winkels auf 90 grad, also ein Vollkreis von 360 grad in 4 Teile (parts) geteilt werden.
« Teiler eingeben (hier 4).

« Mit Shift + Linksklick Polygon zeichnen. ( 3% Snap Vertices Tools | Skins |

«  Mit Strg + Linksklick Polygon schlieRen. | Constraints [ Snap/Grid | View /Edit
Length
|| Constrain length to nearest model units

Incremental Angle (Shift to activate; Ctrl to close)

[¥] Constrain angle by steps of 90.0 degree
by dividing 360 degrees into: | 4| parts

Rechtwinklige Geb&ude digitalisieren. Einen Vollkreis in 4 Teile teilen.
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Geometrien

3.4.3 Constraints>Angle

Bei Constrain to relative angle wird der Winkel
linkslaufig zur gedachten Verldngerung der gezeichneten
Seite gesetzt.

Bei Constrain to absolute angle wird der Winkel
linkslaufig zur gedachten x-Achse gesetzt.

«  Winkel eingeben (hier 45.0).

«  Constrain to relative/absolute angle wahlen.
. @ Draw Constrained LineString wahlen.

«  Mit Shift + Linksklick Linienzug zeichnen.

[ 3% Snap Vertices Tools | Skins |

[._

Constraints | Snap/Grid | View/Edit |
Length
L| Constrain length to nearest model units

Incremental Angle
| | Constrain angle by steps of 90.0 degree

by dividing 360 degrees into: parts
Angle (Shift to activate)
Constrain to angle | 45.0| degrees

s +
‘@ Constrain to relative angle D

o 5 +
_ Constrain to absolute angle 1\
—_

i OK l I Cancel |

Relativer oder absoluter Winkel.

Der grune Linienzug wurde mit einem relativen und der blaue Linienzug mit einem absoluten Winkel von 45

grad gezeichnet.

b Constraints

¢ [ Working
M [¥|bogen
[ [¥] nilfslinie
[T [v|relative
B [v]absolute
(] System

. 95
. -x?’aqr
L&)
.\ﬁ /ﬂ
%

g A\ /
e/ .
//"I a?/
v\
//.'l / i’z.\éo /
i B "

Wirkung von relativem und absolutem Winkel.
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3 OpenJUMP 1.2 Tutorial (Grundlagen)

3.5 Features markieren, verschieben, skalieren und drehen
Bevor Features verandert werden kénnen, missen sie markiert werden und der Layer editierbar sein (S. 24)!
Q Ganzes Feature markieren.
‘Q Teil einer Geometry Collection (S. 18) selektieren.
15 Ein Loch (hole) markieren.
1o Genau ein Feature markieren.
@ Feature verschieben.
a Feature skalieren (vergréfiern oder verkleinern).
C) Feature drehen
«  Ein oder mehrere Features markieren.
« Funktion Rotate Selected Item C) wabhlen.

» Die Shift-Taste festhalten (Cursor wird zum Kreuz) und den Drehpunkt mit Linksklick wahlen.

«  Shift-Taste loslassen und Feature mit Linksdruck drehen.

3.6 Mehrere Features zusammenfassen (Geometry Collection)
Es kénnen die Geometrien mehrerer Features zu einer logischen Einheit zusammengefasst werden. Hierbei
missen sich die Features auf einem Layer befinden.

Achtung: Beim Zusammenfassen kénnen Sachdaten (S. 36) der Features verloren gehen.

Features, die zusammengefasst werden sollen, mit Shift + Q markieren.

Rechtsklick auf grafisches Fenster.

Im Kontextmenli: Combine selected features.

3.6.1 Features auflosen

+  Geometry Collection mit Q markieren.
» Rechtsklick auf grafisches Fenster.

« Im Kontextmeni: Explode selected features.
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Geometrien 3

3.7 Knoten (vertex, vertices) bearbeiten

h'\l'_ Knoten (vertex) zu einem Feature hinzufiigen
» Feature markieren.
» Funktion Knoten hinzufiigen wahlen.

« Mit Linksklick Knoten auf Liniensegment einfigen.

\:?(_ Knoten I6schen
- Feature(s) markieren.
« Funktion Knoten I6schen wéhlen.

« Mit Linksklick Knoten I6schen.

@ Knoten verschieben

« Feature markieren.

« Funktion Knoten verschieben wéhlen.
« Mit Linksdruck Knoten verschieben.

w¢
2= Knoten zusammenfassen

« Ersten Knoten mit Linksdruck anwahlen und auf zweiten Knoten ziehen.

%ﬁ Zwei markierte Knoten zusammenfassen

« Feature markieren (Funktion arbeitet nur mit einem Feature!).

«  Werkzeug wahlen und mit Linksdruck Rahmen um beide Knoten ziehen.

- Shift-Taste driicken und auf den Zielknoten innerhalb des Rahmens klicken.

Q" Knoten unter Bedingungen verschieben.

Die Bedingen werden in der Editing Toolbox unter Options... unter dem Reiter
Constraints festgelegt (siehe Seite 16).

«  Feature markieren.

« Funktion Constrained Move Vertex auswahlen.

«  Den Knoten mit dem Cursor-Kreuze fangen und mit Shift + Linkdruck den Knoten
verschieben.

« Hinweis: Wird die Shift-Taste nicht gedriickt, haben die eingestellten Bedingungen keine
Wirkung.
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3 OpenJUMP 1.2 Tutorial (Grundlagen)
3.8 Linienzug (Linestring) teilen

B% Linienzug teilen
« Feature markieren.

« Mit Linksklick Linienzug teilen.
a’ﬁ Linienziige die sich schneiden an Schnittpunkt teilen

« Beide Linienziige markieren.
« Mit Linksklick auf Schnittpunkt klicken.
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Kategorien und Layer

4 Kategorien und Layer

4.1 Allgemeines

Layer sind Ebenen zur Darstellung von Features (S. 13, Vektorlayer) oder Rasterdaten. OpenJUMP kennt

verschiedene Arten von Layer-Typen (Vektorlayer, Datenbank-Layer, MrSID-Layer, Image-Layer, Raster-

Layer, WMS-Layer). Hier werden nur der Vektorlayer, der Raster-Layer (Uber ein Plugin) und der WMS-Layer

vorgestellt.

Die linke Seite des Projektfensters zeigt eine Ubersicht aller vorhandenen Layer im Projekt. Layer kénnen

unter Kategorien (category; z.B.. Vegetation, Verkehr, Topographie, Gebaeude, Grundstuecke, u.s.w)

zusammengefasst werden. Durch geschickte Auswahl von Layernamen kann schon ein einfaches

Informationssystem erstellt werden. Im unteren Beispiel werden alle Layer mit einem Hakchen angezeigt.

Alle anderen Layer sind ausgeschaltet. Wurde der Layer mit Color Theming (S. 41) bearbeitet, kann eine

Legende zum Layer durch Linksklick auf das Schaltsymbol des Layers angezeigt werden.

File Edit View Layer Tools Customize Window Help

dd@merane-eHE kree A = |« O

= s00m

- GeoCity

7 [ Vegetation
Schalt- W [] Bacume

L5 ] Verkehr
symbol ¥ HafenStrasse —

B || Strassen
& ] Topographie
¢ [ Gebaeude
[¥| GebaeudePrivat
B ¥ GebacudeGewerbe
B [ Funka
(] Funks
) B ¥l Bauernhol
Kategorie — B - = Gundstuecke
[¥] Wohngebiet
v Stadtpark
Layer 8 = |landwirschaft
Acker
H Getreide
Grimband
Hof
= wald
O |vl Gewerbegebiet
= lvl Feuchtbiotop
& [] Abwasser
¢ ] HiltsPunkte
] Raster -

Legende —

Bt - L

Grimand

Acker

F e

SIuH
&
g
%
%,

i

" Getrelds |

;‘H

'
1,

a

Landstrap,

@

Sy
® § Y

R

=]

[Number Selected: 0(0,0)0pts 66 MB Committed Me...

[63963.2, 51837.2)
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4 OpenJUMP 1.2 Tutorial (Grundlagen)

4.2 Kategorien

Far eine sinnvolle Strukturierung kdnnen Layer unter Kategorien zusammengefasst werden.
Mit Layer>Add A New Category kann eine neue Kategorie angelegt werden. Die neu erstellte Kategorie
New Category kann durch Doppel-Linksklick umbenannt werden.

File Edit View Layer Tools Customize Window
i o (@4 AdaANewLayer
¥ Geocty Run Datastore Query. B open P
ﬁ > File Edit View Layer Tools Customize Window
1L4) Add MrSID Layer e -
7 CIGundstue g awnes uery.. dd QAT @ QT e & OpenJump
wiv Add image Layer (Test, ECW DLL: ¥ GeoCity File Edit View Layer Tools Customize Window
[~ New Categor= - id|lg Q‘Qﬂ? [~ YR o Rleq ™
§ CResun  NewCategory :
[ wiBur ol Add A New Layer Y oeothy
1 Working 4 Open... P = Iop-oq'v. n T
Rdrioon Setbeind KU CSystem ofLoad Dataseis).. Wl Add A New Layer
Ca now 1 Ly # O Sonstiges PETOIEY v Tq
CIA Remove Selected Categories [¥] Gex o 251076 Layer... [ Working o Open...
¢ 7 HiltsPunkt Change SRID. [lBes Add 3 WHS Query... = New Categ *oau Dataset(s)...
mH Fieaama Salecin Lt % CVegetation Add Image Layer (Test, ECW [ ¢ [ Result Add Datastore Layer...
B [ |H  Addnew raster layer B ¥ Bat Paste Layers O e Add a WMS Query...
@ [HP_Grundstuec | ¢ T Verkehr Bemove Selected Categories ] System Add Image Layer (Test, ECW DL
B []HP_Teich 7] Hat ¥ 2> Set Category Visibility... ¥ (] Sonstiges | Dt Linere
CRaster | ® sy, ¥ Move Category To Top.. (] Gy R Sasd e
(-] New Category = ¢ CTopographig % Move Category One Up.., = B{% %) set Category Visibility...
¥ Teir ¥ Move Category One Down... $ = ve:fl.tr_or; e
Cop . B ¥ ru ¥ Move Category To Bottom... ke
Neue Kategorie hinzufiigen. e : ¢ C]Verkehr # Moye Category One Up...
= wn| ¥ Move Category One Down...
Neuen Layer hinzuftigen. W st ¥ Move Category To Bottom...

Markierte Kategorie I6schen.

Durch Rechtsklick auf die Kategorie kénnen z.B. neue Layer hinzugefiigt werden (Add A New Layer) oder
Dateien geladen werden (Load Dataset(s)...). Mit Remove Selected Categories kann die Kategorie geléscht
werden. Die Layer der geléschten Kategorie werden dann in die Kategorie Working verschoben. Mit Hilfe
eines PIROL Plugins (CategoryTools.jar; S. 73), kdnnen alle Layer der Kategorie sichtbar oder unsichtbar
gemacht werden (Set Category Visibility...). Aullerdem kénnen die Kategorien in der Hierarchie verschoben
werden (Move Category...).
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Kategorien und Layer 4

4.3 Vektorlayer

Vektorlayer ...

« ... haben einen Namen.

« ... kénnen kopiert, ausgeschnitten, geléscht, eingefligt und in der Hierarchie verschoben werden.
« ... kénnen zu Kategorien (category) zusammengefasst werden.

« ... kénnen in einer Datei oder Datenbank gesichert werden.

« ... haben eine farbliche Darstellung (Rendering, S. 39).

« ... kdénnen in Abhangigkeit von Feature-Attributen verschiedenartig dargestellt werden
(Thematische Darstellung, S. 41, Beschriftung, S. 44).

« ... haben ein Attributschema

(siehe Schema erstellen und bearbeiten, S. 37, und Sachdaten bearbeiten, S. 38).

Unter dem Menilpunkt Layer kénnen u.a. Vektorlayer, Rasterlayer (S. 26), WMS-Layer (S. 29) und

Kategorien (S. 22) erstellt werden.

& OpenJUMP
File Edit View |Layer | Tools Customize Window Hel
_. |'__d| 0! Q é Add A New Layer Neuen Layer hinzufiigen
“‘ G e Add Datastore Layer... Datenbank-Layer hinzufiigen.
oCHy ;-2 Run Datastore Query... Datenbank Abfrage.
¢ [ Topograpt Add MrSID Layer MrSID-Layer hinzufigen (Rasterformat).
o F Add a WMS Query... WMS-Layer hinzufiigen.
O |v . .
CIw k' K Add Image Layer (Test, ECW DLLs de: Rasterlayer hinzufiigen.
orking .
Add A New Cateqo Neue Katagorie.
(] New Cate = gory
9 m Result Cut Selected Layers Markierte Layer ausschneiden.
O [¥IB Copy Selected Layers Markierte Layer kopieren.
em Paste Layers Kopierten Layer einfiigen.
(] Syst P aye
¥ Ei Sonstiges X Remove Selected Layers Markierte Layer I6schen.
| [ £l
g Remove Selected Categories Markierte Kategorien I6schen.
Change SRID... SRID &ndem.
9 [] Vegetatior = )
m B Rename Selected Layer... Markierten Layer umbenennen.
¢ [ Verkehr Add new raster layer Rasterlayer hinzufiigen (mit PIROL Plugin).

Layer verwalten.
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OpenJUMP 1.2 Tutorial (Grundlagen)

Mit Rechtsklick auf den Layernamen kénnen spezielle Layereigenschaften bearbeitet werden.

& OpenJump

File Edt \iew Layer

Tools Customize Window Help

Hd A eaage- 9E XSO @ =

- GeoCity

¢ [ Gebaeuds
] Funkg
| [v]

B (v Gebaeuf
¥ Gebaew
¢ [ Topographie
W [v|Fuss
¥ Teich
[ Working
[ New Category
¢ [ Result

O [v]Fence
¢ [Z3Sonstiges
v] GeoCity
_|Beschrg
7 [ Vegetation

| (¥ FunkA T

¥ [ Selectable
Layer Properties...
. Zoom To Layer
Q Change Styles..
Copy Styles
Paste Styles

| B3 View | Edit Attributes

@view /Edit Schema
Image Layer Manager (Test),
Save legend.
\} Save Selected Datasets
resh-Layer..

|| Save Dataset As...

A(ker
Ackar

Bt g

B

Getizide
L

M il Bosue Rename Selected Layer
PV st | MoveLaver Up
| & Move Layer Down
B [v]Strasse————————————
¢ [ Grundstuecke Ci Selected Layers
v Wohinge Copy Selected Layers
V] Stadtpa, X Remove Selected Layers
- m Landwlli & Add New Features...
O Gem:hf Paste hems
1 [wiFeuchtts & Delete All Features
¢ [ Abwasser Select Current Layer Nems
.| Abwasg Toggle Visibility
_|Mbwass  © Exiract Layers by Geometry Type

¢ [ HiltsPunkie 1 Extract Layer in Fence
W [HP_Achsen || |
m HOD Rahaanda

[ Number Selected: 2 [209.6, 350.3.. [17 MB Committed Me._.

.h Funmsai—a : u gl '
— a ‘ \ S :'

—//

§63793.4,51779.5)

Rechtsklick auf Layername.

Editable: Um einen Layer bearbeiten zu kénnen, muss er editierbar sein! Wird ein Layer editierbar gemacht,
wird die Editing Toolbox eingeschaltet.

Selectable: Items kdénnen selektiert werden.

Layer Properties...: Layereigenschaften anzeigen.
Zoom to Layer: Den gesamten Layer anzeigen.
Change Styles... : Layerdarstellung dndern (S. 39).

Copy Styles: Layerdarstellung kopieren.

Paste Styles: Kopierte Layerdarstellung ibernehmen.

View / Edit Attributes: Layerattribut ansehen oder &ndern (S. 38).

View / Edit Schema: Schema fir Attribute ansehen oder &ndern (S. 37)

Save legend: Legende (S. 21) kann als .png Datei gespeichert werden.

Save Selected Datasets: Alle markierten Layer in Datei sichern. Achtung: Nur bereits gespeicherte Layer
kénnen hiermit gesichert werden!

Save Dataset As...: Layer in Datei oder in PostGIS-Tabelle (mit Plugin, S. 63) speichern.

Rename Selected Layer: Markierten Layer umbenennen.
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Kategorien und Layer

Move Layer Up: Layer nach oben verschieben. Héhere Prioritat fur Darstellung.

Move Layer Down: Layer nach unten verschieben. Niedrigere Prioritét fur Darstellung.

Cut Selected Layers: Markierte Layer ausschneiden.
Copy Selected Layers: Markierte Layer kopieren.
Remove Selected Layers: Markierte Layer I6schen.

Add New Features: Geometrien im Well-Known Textformat (WKT, S. 70) hinzufiigen.

Paste Items: Kopierte Items einfugen.

Delete All Features: Alle Features auf Layer I6schen.

Select Current Layer Items: Alle ltems markieren.

Toggle Visibility: Sichtbar/unsichtbar machen.

Extract Layers by Geometry Type: Nach Geometrietypen aufteilen und auf neue Layer speichern.

Extract Layer in Fence: Features im Auswahlrahmen auf neuen Layer.

Layer>Change SRID...: SRID-Information fiir Layer dndern (nur unter dem MenUpunkt Layer zu finden; nur

bei PostGlS-Datenbankanbindung sinnvoll, S. 63).

HCU Hamburg, Department Geomatik
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4 OpenJUMP 1.2 Tutorial (Grundlagen)

4.4 Rasterlayer

Mit Hilfe eines PIROL Plugins (S. 73; rasterlmage.jar) kénnen Rasterdaten geladen und georeferenziert
werden. Das Plugin unterstiitzt die Formate GIF (Graphics Interchange Format), TIFF (Tag Image File
Format) und PNG (Portable Network Graphics). Liegt ein Worldfile zu der Rasterdatei vor, wird die Datei
anhand der Informationen im Worldfile georeferenziert. Liegt kein Worldfile vor, wird die Rasterdatei Uber die
linke untere und rechte obere Ecke Uber Passpunkte georeferenziert und dann ein Worldfile erstellt.

Es ist sinnvoll, eine neue Kategorie (S. 22) im unteren Bereich der Layerstruktur anzulegen (hier Raster),

damit der Rasterlayer die Vektorlayer nicht Uberdeckt.

File Edit View |Layer | Tools Customize Window Help
il o Q{ Add A New Layer

~ - Add Layer...
;m\::m x:winla‘:‘“"' ¥ Il No Worldfile (.Z:\eis 2\GeoCity\orthoGC.gfw) found - please enter the ... @
. g ::;:“ Add a WMS Query... T
g MddimageLayer (Test, ECWDLLS deactivated).. | Select (set) the file name and path and set the extent.
Add A New Category

Os
¢ [ Vegetatior Cut Selected Layers

m B Copy Selected Layers ' e Please enter the image path (this plugin accepts TIFF, PNG and GIF formats) and
? CVerkehr | pasteLayers = e Extent. Then press Finish to add image to the Task.
B H X Remove Selected Layers
{ dulo :';‘:  Selected Categories ¥ MinX: West coordinate
gy  ChewesRO- | Acker MaxX: [East coordinate
WG iR e | MinY: |South coordinate
¢ T Gabooude DR o S oo
] Gebasudepriva] | ? 1\ Getreide MaxY: |North coordinate
B [¥] GebaeudeGewe | ¢ — W\ s
B [v] FunkA | Flinkha
] Funka | m il = z T - @
& = s E No Worldfile (.Z:\gis 2\GeoCity\orthoGC.gfw) found - please enter the ...
¢ [ Grundstuecke g \
lv| Wohngebiet g f & @ Select (set) the file name and path and set the extent.
v] Stadtpark o/ e,@ .
o w (¥l Landwirtschaft N . |
[ vl Gewerbegebiet
B [ Feuchibiotop Please enter the image path (this plugin accepts TIFF, PNG and GIF formats) and
o unna;s;[ > Extent. Then press Finish to add image to the Task.
Number Selected: 0 [0, 0] 0 pts b-ﬂ MB Committed Me... =
MinX: 63900
MaxX: 64600
Rasterdatei laden. MabY:151150
Maxy: 51800
Liegt kein Worldfile vor, missen die Passpunkte
der linken unteren und rechten oberen Ecke in
den Textfeldern eingegeben werden: . |
< Back Finish : Cancel |
MinX (West coordinate) = Minimaler Rechtswert; linke untere Ecke; Passpunkte eingeben.

MaxX: (East coordinate) = Maximaler Rechtswert; rechte obere Ecke;
MinY: (South coordinate) = Minimaler Hochwert; linke untere Ecke;
MaxY: (North coordinate) = Maximaler Hochwert; rechte obere Ecke;

Nach Finish wird das Bild georeferenziert und ein Worldfile im Bildverzeichnis angelegt!
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Kategorien und Layer 4

Hier wurde GeoCity ,beflogen und aus dem Luftbild ein Orthofoto erstellt. Der Rasterlayer OrthoPhotoGC
liegt unter der Kategorie Raster. Die daruber liegenden Layer werden dadurch nicht Uberdeckt, sind
allerdings hier ausgeschaltet.

& OpenJUMP
Do E& Vou Lmw lods

idlie @

i
§3
i.

[ [ Gewerbegebiet |
5[] Feuchtbiotop
¢ ] Abwasser
|
I ] AbwasserAbfiu
¢ I HilfsPunkte
B [ |HP_Achsen
B [ HP_Gebacude
] HP_Grundstuec
B [ HP_Teich
¢ [ Raster

[ [prnoFotoce]

o [ Result =

. N -

ml Selected: 0 [0, 0] 0 pis ﬁsm Committed Me... I [63332.1. 51513.1)

L

Orthofoto von GeoCity auf einem Rasterlayer.

& OpenJUMP
File Edit View Layer Tools Custo

Ld = @ h'. o ﬂ =lieaizali

11 [v] Stadtpark
& = (¥l Landwirtschaft |
[ [¥] Gewerbegebiet |
7 [¥] Feuchtbiotop |
7 ] Abwasser = |
=
7 | Abwasser Abfu|
7 ] HiltsPunkte
W [ |HP_Achsen
B [ |HP_Gebaeude
B [ HP_Grundstuec
B [HP_Teich

ml Selected: 00, 0] 0 pts 109 MB Committed M... I [545?5..8. 51695.2)

Die Vektorlayer iiberdecken den Rasterlayer.
Das Orthofoto kann als Grundlage fiir die Digitalisierung bestimmter Objekte dienen. Hierbei ist darauf zu
achten, dass der Rasterlayer unterhalb der Vektorlayer liegt.
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4 OpenJUMP 1.2 Tutorial (Grundlagen)

Durch Rechtsklick auf den Rasterlayer kénnen bestimmte Funktionen des Rasterlayers angesprochen
werden:

& OpenJUMP
File Edit !Im me ]_ools. glmorllu. Window Help ) ) -
dd Qe @Rl @6 @ = we O ——O0— swm

7 ] Raster -
N
Clworking |
¢ [ System @ Toggle visibility i
[0 [¥|Fenc{  Change Raster mage Properties...
¢ [JSonstiges | B Exract Selected Part Of Image...
[6eoC  gove Rasterimage As lmage...
ClBesc i s o

- Zoom to selected layer...

B [v]Baeu Warp image fo fence...
¢ [ Verkehr Export bounding box as geometry...
e
W [v]Stras
7 [ Topographie
7 [l Teich
W (v Fluss

Cut image layer...
Copy image layer...
Remove selected image layer...
e EehnudanMJ
B | GebaeudeGewe |
B ¥ FunkA
¥l FunkB
B [¥| Bavernhof
¢ [ Grundstuecke
[¥] Wohngebiet
vl Stadtpark |
o & [¥]Landwirtschaft v

=3

Rechtsklick auf Rasterlayer.

Auswahlrahmen .

Toggle visibility: Sichtbarkeit schalten.

Change Raster Image Properties: Bildeigenschaften verandern.

Extract Selected Part Of Image...: Mit |§|selektiertes Teilbild (Auswahlrahmen) auf neuen Layer legen.
Save Rasterlmage As Image...: Bild in Datei speichern.

Zoom to selected layer...: Auf maximale Ausdehnung des Rasterlayers zoomen.

Warp image to fence...: Bild in Auswahlrahmen einpassen.

Export bounding box as geometry...: Ein Polygon (Rahmen) um das Bild legen. Hinweis: Es wird ein neuer
Layer mit dem Polygon angelegt.

Move Layer Up...: Layer innerhalb der Kategorie nach oben verschieben.

Move Layer Down...: Layer innerhalb der Kategorie nach unten verschieben.

Cut image layer...: Bild kopieren und I6schen. Mit Rechtsklick auf eine Kategorie (S. 22) und

Paste raster layer... kann das Bild eingefligt werden.

Copy image layer...: Bild kopieren. Mit Rechtsklick auf eine Kategorie (S. 22) und Paste raster layer... kann
das Bild eingefligt werden.

Remove selected image layer...: Rasterlayer |6schen.
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4.5 WMS-Layer

Die von einem WMS-Server (Web Map Service) zur Verfligung gestellten Daten kénnen in OpenJUMP auf
einem Layer dargestellt werden. Dieser Layer dient nur zur Darstellung der WMS-Daten und hat nicht die
Eigenschaften eines ,normalen® Layers. Es kann z.B. auf diesem Layer nicht gezeichnet werden. Dieser
Layer kann aber als Grundlage zur Erweiterung des Informationssystems dienen, indem man z.B. durch
Vektorisierung neue Geometrien erzeugt und mit Attributen verkniipft. Uber Layer>Add a WMS Query wird
die URL (Uniform Resource Locator) des WMS-Servers eingegeben. Der WMS-Server kann verschiedene
WMS-Layer anbieten, die man mit dem Knopf Choose Layers auswahlen kann.

Achtung: Méchte man die WMS-Layer auch in OpenJUMP auf verschiedenen Layern darstellen, muss man

diesen Vorgang (Layer>Add a WMS Query) fur jeden WMS-Layer wiederholen!

¥ Connect To Web Map Server E] ¥ Connect To Web Map Server E]

Select Uniform Resource Locator (URL) Choose WMS Layers
Please enter the URL of the WHMS server. Please choose the WHMS layers that should appear on the image.
Then press Next to establish the connection,
fovailable Layers v Sort | & Chosen Layers
URL: i
3 desgree demo-CD top-level-layer [E[* > & europe:country [EPSG:314
1.0.0 110 ® 111 o [ GEOnet Names Server layers [E

o [ cite layers [EPSG:4326]
& gurope;country [EPSG:31468, EF

1l ] [»] (4] I [v]

<Back | Hexd > Cancel

Back | Mext > Cancel

URL des WMS-Servers eingeben. WMS-Layer wéhlen.

Der WMS-Server kann die Rasterdaten in unterschiedlichen Koordinaten-Referenzsystemen (Coordinate
Reference System; CRS) schicken. Fir die Darstellung muss ein entsprechendes System gewéahlt werden.
Hierbei werden die Systeme nach der EPSG-Notation angegeben (European Petroleum Survey Group).

Mit Finish wird die Auswahl beendet. Es kann

SRR Coixiuia MGy Sy allerdings passieren, dass das Grafikfenster leer bleibt.
Mit View>Zoom to WMS layer kann dann auf einen

The layers you have chosen support more than one Coordinate Reference
system. Please choose the one that matches the rest of your data.

markierten Layer gezoomt werden. Je nach Auslastung

Coordinate Reference System: Geographics | v

fressm des WMS-Servers kann es einige Sekunden dauern,
— bis das Bild aufgebaut wird.
< Back I Finish Cancel

Koordinaten-Referenzsystem wéhlen.

HCU Hamburg, Department Geomatik 29



4

OpenJUMP 1.2 Tutorial (Grundlagen)

In unserem Beispiel sind zwei Layer vorhanden, auf denen die Grafiken der WMS-Layer dargestellt werden.

Mit Rechtsklick auf einen Layer kann dann mit Zoom to WMS layer auf die Gesamtansicht, bzw. auf die

Bounding Box, des WMS-Layers gezoomt werden. Eine Bounding Box definiert einen Rahmen fir einen

WMS-Layer.
Bl Europa i i o B
¢ [ Working I
&% [v| europe:major_rivers I
&4 v europe:cor™* '
= oo europe: country
Edit WMS query...
Move Layer Up
Move Layer Down
Cut selected layers
Copy selected layers

Remove selected

layers

Toggle Visibility

Zoom to WS layer

decgree WS 2004

Die Fliisse Europas.

Liegen verschiedene WMS-Layer auf einem OpenJUMP-Layer, kann mit Zoom to WMS layer auf die

entsprechende Bounding Box des WMS-Layers gezoomt werden. AuRerdem kann man mit dem | » | Knopf

verschiedene Informationen Uiber die gesendeten Daten des WMS-Servers bekommen. In der unteren Tabelle

sehen wir z.B. den Titel, den Namen, das SRS (Spatial Reference System; Raumliches Bezugssystem) und

die Ausdehnungen der zugehdrigen Bounding Boxen.

30

InfoTable

[j:]

X
Titie ] Name SRS Mini MinY' M Maxy

deegree demo-CD top-lev... Unknown [epsg4326 | -178.9| -89.9| 178.8] 899=
deegree demo-CD top-lev. |Unknown |Iation | -180] -90, 180 [T
(deegree demo-CD top-lev.. |Unknown (epsg4326 | -179.9| -88.9| 179.9 894
cile layers [Unknown lepsgi4326 | 1789 9.9 1799 899 |
cite layers [Unknown [lation | -180] -90] 180 90
cile layers [Unknown lepsg4326 | 179.9] 3.9, 179.9] 89.4
cite:BasicPolygons |cite:BasicPolygons lepsg4336 | -10] -10 10, )
cite:BasicPolygons eite BasicPaolygons llation | -10] -10, 10] 10
cite:Bridges [eite:Bridges lepsg 4326 | -1 1] 1 1
|cite Bridges |cite Bridges liation_ | 1 -] 1] 1
cite BulldingCenters |cite BulldingCenters [Epsg4326 | 1 -] 1| 1
cite BuildingCenters |cite:BulldingCenters [Iation | 1 ] 1 1
cite:Bulldings [cite:Buildings epsg4326 | -1] -1] il 1l
cite:Buildings cite Buildings lation | -1 -1 1| 1
[cite DividedRoutes |cite:DimdedRoutes epsg4326 | 1 -1] 1| 1
cite: DividedRoutes |cite:DividedRoutes [iation | 1] ] 1 1l

it F arest pnsm AT al ol 1 ]

ritp-E nrast
1)

(o]

Informationen (ber die WMS-Layer des WMS-Servers.
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Kategorien und Layer 4

4.6 Layer sichern (Save Dataset As...)

Jeder editierte Vektorlayer muss einzeln gesichert werden! Es stehen verschiedene Formate zur Verfiigung
(JUMP GML, GML 2.0, FME GML, WKT, ESRI Shapefile, PostGIS Table), die mit Hilfe der Auswahlliste
hinter Format: ausgewahlt werden muissen. Hier wird nur das JUMP GML und das PostGIS Format
behandelt.

Mit Save Dataset As... (Rechtsklick auf den Layer) wird der Layer gesichert. Die Datei bekommt bei dem

JUMP GML (Geography Mark-Up Language) Format automatisch den Suffix .jml.

File Edit View Layer Tools Customize Window Help
We QM@ AT e QH K ®0 A ™ [m] L= 16m
¥ GeoCity il =
§ ] Vegetation =
[ lv|Baeums Ll
ClWorking ~ Baeume GeoCity |
[ System £/ Editable
[ Sonstiges ¥ [} Selectable
¥ GeoCit Layer Properties...
— Basch o .
L 4, Zoom To Layer Gronland 8]
L ¢ [j\"ef_m"_'_ Hatord &) Change Styles... ‘
= [¥] Hatent i
B [v)Sirass ;::’::;; g 4
E Acker
¢ (] Topographie
et | e et § T
¥ Teich S - e
B Zfuss | EView Edt Schema = Look i (] GeoCityDe REENEENE
¢ ] Gebaeude Image Layer Manager {Test)... = i} 1= :
¥| Gebae Save legend. i Ty G [ AbwasserAbflussjml [} Funkajmi [ HP_Gebaeude jmi [ Teichjmi
B [v]Gebae ' Save Selected Datasets = S | Abwasserzufussimt 1) FunkBjmi [ HP_Grundstueckejmi [ Wohinget
v Fllnlm_ Befresh-Layer ? _j Baeume.jml [ GebaeudeGewerbe.jmi [ ) HP_Teichjmi
vl FImItB! |~ Save Dataset As... | E 0 jmi 0 watyml [ )L jmi
W ¥Bauerl  poime Selected Layer ] | Beschremungimi [ GeoCityBeschrjml [ New (3pjmi
¥ I‘;‘I&nmﬂywka Move Layer Up [ Buffer-FunkAjml [ Gewerbegebietjmi [} New.jmi
] Wohny Ko Liwer Doeurs efﬁ [ Feuchtbiotop jmi [ HafenStrasse.jmi ) stadtpark.jmi
] Stadtp | | e a
. £ L) Fluss.jmi HP_Achsenjml Strassen.jmi
> & i Cut Selected Layers - .j O - b .
O [ Gewer Copy Selected Layers 4] 13
: Rt Selected L r
W [ Feucnq_ % Remove Selected | ayers File Name:  [Basume
¢ ] Abwasser Add New Features r -
— e i Files of Type: |JUMP GML (*jmi) o
City.jmp) —
—
Format: |JUMP GML !v:
MUMP GML
oML 20
FME GML
Layer im JUMP GML Format sichern.
Auswabhlliste

Soll der Layer in einer PostGIS Tabelle gespeichert werde, muss ein Plugln installiert sein (S. 63).

Hinweis: Dateien im JUMP GML Format oder PostGIS Format enthalten nur Geometrien und die Sachdaten.
Es werden keine Informationen Uber die Ausgestaltung des Layers gespeichert. Diese Informationen stehen
in der Projektdatei (S. 33 )!

Achtung: Dateien im WKT-Format (Well Known Text, S. 70) enthalten nur Geometrien! Die Sachdaten
(Attributwerte) werden hier nicht gespeichert.
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4 OpenJUMP 1.2 Tutorial (Grundlagen)

Wurden Layer mindestens einmal gesichert, so kdnnen mehrere Layer zusammen gesichert werden. Hierzu
werden die zu sichernden Layer markiert. Dann mit Rechtsklick auf einen der Layer und mit

Save Selected Datasets die markierten Layer sichern.

¥ GeaCity
7 [ Vegetation =
1 (v|Baguena I ; =~
CiWorking _ (12/ayers selecton) L\
I System 7,/ Editable |
¢ ClSonstiges | ¥ [y Selectable
v|Geo Layer Properties...
| Bes; . Zoom To Layers
¢ CIVerketr | Change Styles
! vHa“ Cogy Styles |
W ]St o
| Paste Styles <
¥ G‘OWam‘wu View | Edit Attributes aCker #
v Teid b -
B I Flus w | Edit Schema =
¢ 1 Gebaeude | Image Layer Manager (Test). . |
| Gebl Save legend. P .' X
[ vGeh i SaveSelected ——=
B _-_r_iFm{ Refre yor | i
Vil - - W |
B [v|Bau Rename Selected Laver =

Markierte Layer sichern.

4.7 Datenséitze laden (Open File...)

Mit File>Open File... kbnnen Datenséatze in bestimmten Formaten geladen werden. Das Format kann im
unteren Auswahlfenster (Files of Type:) eingestellt werden. Die Datensdtze werden als Layer unter der

markierten Kategorie eingefiigt. Alle markierten Dateien im Auswahlfenster werden geladen.

& Open File... E|
Select Files
Select the files 1o load into the current project

Look In: [ GeoCityDe |~ :IE;;':"[ Uj,ﬁ[ﬁ:
[ AbwasserAbflussjml [} FunkAjml [ HP_Gebaeude.jmi b |
[} Abwasserzuflussimi [ FunkB.jml [0 HP_Grundstueckejmi [y
|:] Baeume.jml D GebaeudeGewerbe.jml D HP_Teich.jml

[} Bauernhof jmi [ Geb rvatjmi [ L jmi

[ Beschreibung.jml [ Geoc jml [ New (3)jmit

[} Butfer Funka jmi ) Gewerbegebietjmi [} New.imi

[ Feuchthictop.jmi D jmi 0 jmil

D Fluss.jml D HP_Achsenjml f:) Strassenjml

] I ]

File Name: 'Ba eumi jml
Files of Type: | JUMP GHIL (~Jmi) —~——— Dateiformat einstellen

Finish Cancel

Die Datei Baeume.jml laden.
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Projekte 5

5 Projekte

5.1 Allgemeines

In einer Projektdatei werden die Kategorien- und Layerstrukturen, die Verweise (Pfade) zu den gesicherten
Datensétzen der Layer und deren Ausgestaltung (z.B. Farbe, Linienstérke, Beschriftung) gespeichert. Neue
Vektorlayer missen zuerst gesichert werden (S. 31), damit der Verweis in der Projektdatei gespeichert
werden kann! Sonst erscheint eine Warnung in der linken Seite der Statusleiste. Die Verweise zu Raster- und
WMS-Layer werden ohne separate Sicherung ibernommen. Eine Projektdatei hat den Suffix .jmp.

5.2 Neues Projekt erstellen (New Project)

Mit File>New>New Project oder mit u;__;i aus der Werkzeugleiste, kann ein neues Projektfenster erzeugt
werden. Das neue Projektfenster mit den Standardkategorien Working und System bekommt den Namen
Project und eine laufende Nummer.

EE""‘ View Layer Tools Customize Window Help

L ¥ 11 New Project | FQ @0 A @ O = L 200m
o Open.. & Layer | -
| Open File... % Category oo B
- Open Project... — B
Open Recent » J PR 1
Somin Totanet Ax ¥ Project 3 o
Save Project =] Working i B JC )
Save Project As... ] System
Save View as SVG
Save View As Raster...

¢ [ Topographie
[¥] Teich
B [v|Fluss
¢ ] Gehaeude
[v] GebaeudePriy
B |v] GebaeudeGey
B ¥l FunkA
¥| Funk@
W vl Bauernhol
7 [ Grundstuecke
] Wotingebiet
& ¥ Landwirtschaft 4 — —
[ [v] Gewerbegebiet '
1% [¥] Feuchibiotop

¢ [ Abwasser d

[00:00:11 (GeoCity.jmp) [ro M8 Committed Me... | [63791.5,51854.7)

Ein neues, leeres Projektfenster.
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5.3 Projekt sichern (Save Project, Save Project As...)

OpenJUMP 1.2 Tutorial (Grundlagen)

Wird ein neues Projekt (S. 33) mit File>Save Project gesichert, erscheint ein Dialogfenster zur Eingabe des

Namens der Projektdatei. Der Suffix .jmp der Projektdatei wird automatisch vergeben. Es missen zuvor alle

Vektorlayer gesichert werden (S. 31), sonst erscheint eine Warnung in der Statuszeile.

Wurde ein bestehendes Projekt mit File>Open Project... gedffnet und anschlie3end gespeichert, so erscheint

kein Dialogfenster. Mit

werden.

34

OpenlUMP

EE“ View Layer Tools Customize Window Help

Nt e 9@ b ee @ =

File>Save Project As... kann das Projekt unter einem neuen Namen gesichert

o Open..

= Open Project... —
Open Recent »

[ Sove Dataset As..
Save Project be |
Save Project As... 3
Save View as SVG |
Save View As Raster...
Exit

B ¥ Strassen
% [ Topographie
[¥] Teich
W [viFluss
¢ [ Gebaeude
| GebaeudePrivat
B |v| GebacudeGewe

W v|FunkA
v| FunkB
B [v] Bavernhof
¢ [ Grundstuecke
[¥] Wohngebiet
v| Stadtpark
o [v] Landwirtschaft

v Feuchtbiotop |~

! Open File... e G b s

E Save Project

Save Inc 'DGE_VCnyDe

[ Geocuyima |

[} GeoCityNewjmp

File Mame:  |GeoCity jmp

Files of Type: |JUMP Project Files (*jmp; *jcs)

O v] Gewerhegebiet| |

rﬁomnlwuu were pot saved to the project file: Ne... iﬂlnlm Selected: 00, 0] 0 pts

[24 MB Committed Me... | 637777, 51816.6)

Nicht alle Layer wurden gesichert!

Projekt sichern.

HCU Hamburg, Department Geomatik



Projekte

5.4 Projekt 6ffnen (Open Project...)

Mit File>Open Project... kann ein bestehendes Projekt (S. 33) gedffnet werden. Im Dialogfenster werden
nur die Dateien mit dem Suffix .jmp angezeigt. Es kénnen mehrere Projekte gedffnet werden. Unter dem

Menupunkt Window kann zwischen den Projektfenstern

Projektfenster auswéhlen

gewechselt werden.

Fibe Edit View Layer Tools Customize Window Help
New e ' @0 A =™ ] 0= 1im
o Open.. -
| Open File... b i ol
| Open Project... =
Open Recent »
Save Dataset As
thr Open Project
:M ::::m - instructions
ave Project As...
Save View as SVG Lookn: |J GeoCityDe - L_j =1 E 88e-
_ SomViawAsRasler. | | H ) Geociy , o' o &
Exit 2w | Geacityima]
W ISwEssen [ GeoCityNeujmp
¢ [ Topographie
i Teich =
B ¥ Fluss -
¢ [ Gebasude
[#] Gebacudepriva | =1 50U
B ¥| GebaeudeGewe
o .‘"": fmuf hd L
File Name: GeoCityimp
¢ Cabwed Fies of Type: |[JUMP Project Files (*jmp; *Jcs) I
< Back Finish ] Cancel ]
et R
B [ |HP_Achsen . :
B [ |HP_Gebacude -
[Number Selected: 0(0,0)0pts 20 MB Committed Me... | [63764.2, 51612.5)

Projekt éffnen.
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6 Sachdaten

6.1 Allgemeines

OpenJUMP 1.2 Tutorial (Grundlagen)

Es gibt verschiedene Methoden, Sachdaten in ein Projekt zu integrieren:

36

(siehe Geometrien, S. 9)

Durch direkte Eingabe in OpenJUMP. Hierzu miissen Geometriedaten vorliegen

Durch Import von Dateien, die in einem bestimmten Format beschrieben sind. OpenJUMP unterstutzt
folgende Formate, in denen allerdings auch Geometriedaten enthalten sind:

a) Das JUMP GML Format (.jml), welches ein einfaches GML-Format ist.

b) Das GML 2.0 Format.
c) ESRI Shapefile.
3. Durch Laden einer Datenbanktabelle im PostGIS Format (nur mit Hilfe eines Plugins, S. 63).

File Edit View Layer Tools Customize Window Help
dd QT @ LA e Q L @0 = Cg= == 1xm
¥ GeoCity o' X©
[ Working e
[ System
¢ [ Sonstiges
[] GeoCityBeschr
: Evewn;llm 5 - itributes: Wohngebiet ‘@ X
= [v| Bacume __ Wohngebiet (14 Features) : —
: #| | _|FID [Vomame [Nachname [Flaeche |
¥ ] Verkehr g [F @k e 13800 -
vl HafenStrasse o 3ot Fant 9037 S
| [v|Strassen Q) [@ od4Helmut  Helmchen 3570 &S‘;
@] 95 Malte Miller 2864
¢ [ Topogra L=l )
=2 W"L.T:c" 9 O 96Frieds  Meyer 1732 fg/
v B| @ o7 Kay Kalman 1218 =7
B v Fluss ¥ [B] 98Jens Jensen 1606 || ¥
7 [ Gebaeude 8| 99 Moritz Moor 2156 |f | /
| GebaeudePrival @ 100 Dieter Daths 1753
’ | O] 101Paule  Schuster 1823
W ] GebasusleGaney @ 1025tadt  GeoCity 3789
B v FunkA 3| 103 Gustay Gang 2202 |hskA -
¥ FunkB @] 104 Stadt GeoCity 4256
e (8 @ 105 Stadt GeoCity 3626
¥l
¢ [ Grundstuecke I
v| Wohngebiet g-
|| Stadipark ~
o e [v|Landwirtschaft |
O |v] Gewerbegebiet |
I [v]Feuchtbiotop | |
¢ [ Abwasser |
Number Selected: 0[0,0]0pts |51 MB Committed Me... | 64141.1,51871.5)

Sachdaten in Tabellenform zu den Grundstiicken.
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Sachdaten 6

6.2 Schema erstellen und bearbeiten

Um Sachdaten mit Geometrien verknlpfen zu kénnen, muss zuerst fir den Layer ein sogenanntes Schema

erstellt werden. Dadurch werden die nicht-raumlichen Attribute (non-spatial attributes) der Features definiert.

Beispiel: Auf einem Layer werden Grundstiicke dargestellt. M6chte man die Namen der Eigentiimer, den
Wert oder z.B. die Flache der Grundstiicke erfassen, so muss man die Attribute zuvor in einem Schema
vereinbaren.

Dieses Schema gilt dann fir alle Features auf dem Layer. Daher ist es bei der Modellierung eines GIS
wichtig, die Layer bzw. deren Schema so zu definieren, dass gleichartige Objekte in einem Layer erfasst
werden kdnnen. Es ist nicht sinnvoll, z.B. Grundstiicke und Badume auf einem Layer zu erfassen, weil
Grundstiicke und Baume unterschiedliche Attribute haben.

Jedem Attribut, auch Feld (Field) genannt, wird ein bestimmter Datentyp (Data Type) zugeordnet, wobei
OpenJUMP den Datentyp Integer (ganze Zahl), Double (Dezimalzahl), String (Text), Date (Datum) und
Geometry kennt. Das Attribut GEOMETRY ist in jedem Schema vorhanden.

Achtung: Der Datentyp Object wird hier nicht verwendet!

Mit Rechtsklick auf den Layernamen erscheint ein Pulldown-Menu. Mit ﬁ\ﬂew [Edit Schema  kann das
Schema bearbeiten werden. Hierflir muss der Layer editierbar sein!

b Edit Schema: Wohngebiet = o @ Pd
 Field Name Data Type I
Attribut einfiigen _+_ GEOMETRY Geometry =
Attribut I6schen x Vorname |String 3
Nach oben .“ MNachname |String B
Nach unten v Flaeche Inteaer v
[integer
Double
Geometry
Object
Date
String -|
Apply Changes : Revert Changes | [ ] Force invalid conversions to null.

Schema fiir den Layer ,Wohngebiet” mit den Attributen GEOMETRY, Vorname, Nachname und Flaeche.
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6 OpenJUMP 1.2 Tutorial (Grundlagen)

6.3 Sachdaten (Attributwerte) bearbeiten

Wurde ein Schema fur einen Layer erstellt, kbnnen die Attribute der Features eingegeben werden. Mit
Rechtsklick auf den Layernamen erscheint ein Pulldown-Meni. Mit B4 view / Edit Attributes kénnen die
Attribute bearbeiten werden. Der Layer muss zur Bearbeitung der Attributwerte editierbar sein! Die
Betrachtung ist aber immer mdéglich.

Die Werkzeugleiste des Attribut-Fensters bietet Funktionen zum Zoomen und Identifizieren von Features,
deren Zeilen in der Tabelle markiert wurden. Méchte man z.B. wissen, welches Grundstiick Klara Fall gehort,
markiert man einfach die Zeile von Klara Fall. Durch Linksklick auf die Lupe Q wird auf das Grundstiick
gezoomt und mit einem weiteren Linksklick auf die Taschenlampe _‘?1 kurzzeitig hervorgehoben.

Um die Funktionen der Werkzeugleiste nutzen zu kdénnen, muss eine oder mehrere Zeilen in der Tabelle
markiert sein.

fiz
b Attributes: Wohngebiet o F X
s \Wohngebiet (14 | Features)

Scrollen und zoomen || | _|FID_|vomame |Nachname [Flaeche | |
—g‘ 0] 153 Klara Fall 13800 |~ |
2] @] 154 otto Fant a037 [ ||

Auf markierte Zeile zoomen Q| @] 155 Helmut Helmchen 3570
Allos Zoomen | |3] 156 Malte Miller 2864 |=

@ 0] 157 Frieda Meyer 1732
Im Grafikfenster markieren _Q| E 158 Kay Kaiman 1218 |

Im Grafikfenster anzeigen j| 3] 159 Jens Jensen 1606
Geometriedaten anzeigen E 160 MPr!E Moor 2256 =
0] 161 Dieter Dachs 1753 |5

Attributtabelle des Layers ,Wohngebiet".

Die Geometriedaten der markierten Zeile kann man sich mit dem Info-Knopr ﬂ der Attributtabelle anzeigen
lassen. Man kann zwischen den Formaten WKT (Well-Known Text, S. 70), GML (Geography Mark-Up
Language) und dem CL-Format (Koordinatenliste) wahlen.

oA X

¥ Feature Info: GeoCity -

B |z Wonmechs
}[E— *@ ohngebiet

@ | FID92
= POLYGON ((64270.3374 51627.0842, 64341.076 51749.2142,
WKT 64492.1932 51719.332, 64386.9769 51653.147, 64365.2645
“GML.: 51630.6959, 64270.3374 51627.0842))

~ |wWell-Known Text|

Geometriedaten im Well-Known Textformat (WKT).
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Layerdarstellung (Styles)

7 Layerdarstellung (Styles)

Die Darstellung eines Layers, und somit der Features auf diesem Layer, kann (Uber das Change Styles

Fenster verandert werden, das Uber den Knopf _ aktiviert wird. Hierfir muss der Layer markiert sein

(Linksklick auf den Layer), aber nicht unbedingt editierbar sein.

Es gibt funf Méglichkeiten zur Bearbeitung: Rendering (Allgemeine Darstellung), Scale (MaRRstabsabhé&ngige
Darstellung), Colour Theming (Thematische Darstellung), Labels (Beschriftung) und Decorations

(Anfangs-/Endpunkt Darstellung).

7.1 Allgemeine Darstellung (Rendering)

Unter dem Reiter Rendering kann Folgendes eingestellt werden:

- Die Farbe der Linien und Fléchen.

« Das Fiillmuster von Flachen (Fill pattern).

« Die Strichlierung der Linien (Line pattern).

« Die Linienbreite (Line width).

» Die Transparenz der Farben (Transparency).

- Die GroRe der Knoten (Vertices Size).

“Rendering | Scale | Colowr Theming | Labels

v Fill: [ =
: OpenJUMP Fill pattern: _1
Tip: After selecting & pattem. use your beybosl’s up and
Eile Edt View Layer Jools Customize Window Help o bt la s o aliar maerd honl 1 URe PRI
1 C ; below
de QM@ QTN Q9QH 190 A m™ [m]}"C : ,
] Line: L - L
¥ GeoCity .
s Sy | Line pattern:
B v| Basume | Sync line colour with fill colour,
¢ [ Verkehr
[] HafenStrasse I . Line width: uo w 20 30 !
B || Strassen -
¢ [ Topographie = . Transparency: =) 105
| Teich
B [¥|Fluss Vertices. Size:
¢ [ Gebaeude
v| GebaeudePrivat L Preview:
B v GebacudeGewerbe
B [ | Funkh
_| FumkB !
B (v Bauernhol 2 Sdpalk
¢ [ Grundstuecke
] Wohngebiet
| Stadtpark
L = v Landwirtschaft
O |v] Gewerbegebiet
% ¥ Feuchtbiotop
% [ HiltsPunkte 7
B | |HP_Achsen F
W [ |HP_Gebacude \
2 I HP_Grundstuecke
B [HP_Teich L
[ Raster - \
Number Selected: 0[0,0)0pts |52 MB Commitied Me... | [64373.6, 51615.5)

Der Stadtpark soll hellgriin dargestellt werden.
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OpenJUMP 1.2 Tutorial (Grundlagen)

7.2 MaRstab (Scale)

Hinter Current Scale: wird der anndhernde KartenmaRstab angezeigt.

Hinter Smallest/Largest Scale kann ein Intervall fir die Sichtbarkeit des Layers eingestellt werden. Im
unteren Beispiel wird der Layer GebaeudePrivat nur angezeigt, wenn der Malistab zwischen 1:1000 und
1:2000 liegt. Dazu muss das Hakchen vor Only show layer when scale is between: gesetzt sein.

& opensump

File Edit View Layer Tools Customize Window Help
deQf @ Que«-@H oo A m O =——0— wm
¥ GeoCity o' o XM
1 Working = ~~_Grinland .
[ System = /
¢ [ Sonstiges
[ ] GeoCityBeschr 1
|_| Beschreibung AT e
& CVegetation Rendering | Scale | Colour Ti |"Labels | Decorations |
@ [v] Bacume | r
¢ [ Verkehr £ Current Scale:  1: 1085 | Show at this scale
7 [¥] HafenStrasse Acker %.'
H [v| Strassen o ol :
¢ 7 Topographie | Only show layer when scale is between:
] Taich Units/Pixel
B [¢|Fluss r
 C3 cebacude @ smotestscoe 12000 | ionshove curen el
v| GebaeudePrivat
B [v] GebaeudeGewerbe C% Largest Scale 1:[1000 | [Fide below current scale|
B ¥ FunkA 4
FunkB /
| (| Bauernhof H /
# [ Grundstuecke f &/
v Wolngebiet Getrelde | " & :
. DEx
=~ m /
[ [v] Gewerbegebiet f_a" E 100m
1% [¥] Feuchtbiotop | f J / -
7 ] Abwasser [t / s'cf M
Number Selected: 0(0,0]0pts 46 MB Committed Me... | {64288.8, 51580.1) »
¢ ] Sonstiges : | | ] /
[] GeoCityBeschr 7
|| Beschreibung | /-’
. | I i -/
i = pa Rendering | Scale | Colour Theming | Labels | Decorations | o
¢ [ Verkehr ' i
() Hat Current Scale: 1: 542 Show st this scale |
W [v]str| ;
1 . /
e °W;:T: [v] Only show layer when scale is between:
LR Units/Pixel %74
i~ o Smallest Scale 1:2000 | [de sbove curent soue]
B ¥ Gel _, ) ] .
u c% Largest Scale  1:/1000 | | Hide below current scale /
¥ Fum /
W (¥ Baernnot &/
¢ [ Grundstuecke &
v Wohngebiet &
v] Stadtpark 7/
& ¥l Landwirtschaft | !
[ |v| Gewerbegebiet ¥ |
I ] Feuchibiotop /
7 [ Abwasser bt | /
Number Selected: 0[0,0]0pts 33 MB Committed Me... | [64276.84, 51463.48)
Die Gebéude werden nicht angezeigt, da der Ma3stab gréer als 1:1000 ist (1:542).
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Layerdarstellung (Styles)

7.3 Thematische Darstellung (Colour Theming)

7.3.1 Allgemeines

Will man eine thematische Karte erstellen, missen vorher Attribute (Attributwerte) fir die Features des
Layers zur Verfigung stehen (S. 37). Die Attributwerte kénnen direkt in eine Farbe umgesetzt werden (jeder
Attributwert steht fiir eine Farbe), oder es kénnen Attribut-Intervalle dargestellt werden.

7.3.2 Direkte Darstellung

In diesem Beispiel haben die Features des Layers Landwirtschaft das Attribut Nutzungsart mit den
Attributwerten Hof, Acker, Wald, Getreide und Griinland.

Das Farbschema kann allgemein mit Colour Scheme oder durch Linksklick auf die Attributfarbe eingestellt

werden. Unterhalb des Layernamens im Layer-Ubersichtsfenster kann die Legende zur thematischen
Darstellung durch Linksklick auf das Schaltsymbol angezeigt werden.

Rendering | Scale | Colour Theming | Labels | Decorations
| [¥] Enable colour theming || By Range
| Attribute: [Nutzungsart |

:tolour Scheme |

_(9)Pastel 1 (ColorBrewer)

| iAttribute
|

& openJunp I

i | IR Paiced Colotremer) CEX
i |Getra (9) Pasted 1 {ColorBrewer)
File Edit View Layer [_oo!s.._E.llslorrln Window um._ :I'n‘. ey
Hid Q™ @5 E ¢ @ I of | 71(9) Set 1 (ColorBrewer) = 200m
I g (8) Set 2 (ColorBrewer) e —
¥ GeoCity : (12) Set 3 (ColorBrewer) = o X
| Beschreitung =
¢ [1Vegetation
B v/ Bacume I
I 1 ¢ [ Verkehr
| @ 1 Landwirtschaft o @ M
| | | I Landwirtschaft (6 Features) |
) , ¢ ][9]} _IF0_INukungsan [Fiaeche [Ertrag Grinland
Attribute anzeigen. § B 5 Hor 1372 10 Wald
dB 86 Acker 9398 25
Iu 87 Wald 10320 50
¢ Gl @//lo] sacetreide 4352 125
B 89 Acker 11379 25
40 Grinland 20895 40
.
= | Acker § a:-'-'
¥ FunkB £ &
B -l
B [ Bauernhof § Acker &,
¢ [ Grundstuecke
[ ] Wohngebiet +
(¥ Stadtpark 3
Schaltsymbol — ¢ \v| Landwirtschaft g ]
Acker I Hof %?
petieide 3 Getreide £
Legende Gribnkand 3 g
Hol 5
unterhalb des oey iy £
Layers. O [] Gewerbegebiet 2 Parkajies
|| Feuchibiotop = ‘a% !
Number Selected: 0(0,010pts |60 MB Committed Me... | k63976, 51759.2)

Thematische Darstellung von Nutzungsarten mit Beschriftung (Label).
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7 OpenJUMP 1.2 Tutorial (Grundlagen)

Durch Linksklick auf eine Farbe in der Spalte Attribute... und Auswahl von Custom (Schiebebalken ganz
nach oben schieben), kann fir jedes Attribut ein individuelles Aussehen eingestellt werden.

- Change Styles P
R e e e
¥ Enable colour theming || By Range

Attribate: Nutzungsart |

Colour Scheme | (9) Pastel 1 (ColorBrewer) lv]l
Atibute .| Aftribute Values I Label

(A1 other values. |

Acker (ACkEr

\GE‘EEIHE |Getreide

Grunland Grinland

Hol Hof

Wald Wiaid

You can use this dialog to change
the colour, line width, and other

visual properties of a layer,
; Custom g'
i (oo ] —
ST T —
CIFill pattern: |1 - :
=
Dtine: | [ ] —
] [ Line pattern: [+~] i
[ o IE [v] Sync line colour with fill colour [ .
—[
Line width: == K
- —
Transparency: === [ 109 =—_ -
o o]

& OpenJUmp
File Edit View Layer ]_ools_glmorriu. Window Help ) ) ) )
do QW @ ATL QL BT @O A ™ @ O ——O0—2mm

¥ GeoCity o ©@

[_| Beschreibung

Grinland

85 Hof
86 Acker 9388 25

87 Wald 1w3z0  soff |
t Y @/lal ssseusice 51 125 \
o 89 Acker 11379 50 |

90 Grinland 20895 4off [ e |

11372

Acker

3
Getreide 5
/ K
£

= wald
[0 || Gewerbegebiet

'.’Ul:w_l_u. L,
0[] Feuchibiotop -

m
>
2
2
8
- U —
“-‘ms;mq"\ reTeaT /
I
g

= J
Number Selected: 0[0,0]0pts |62 MB Committed Me... | [64048.5, 51759.9)

Individuelle Darstellung fiir jedes Afttribut.
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Layerdarstellung (Styles)
7.3.3 Intervall-Darstellung (By Range)

Bestehen die Attributwerte aus numerischen Daten (Integer, Double) und méchte man Intervalle thematisch
darstellen, so muss in dem Kastchen By Range ein Haken gesetzt werden. In Abh&ngigkeit von
Range count werden dann Intervalle berechnet und farblich dargestellt. In diesem Beispiel gibt es zu jeder
landwirtschaftlichen Flache einen Ertrag in Euro pro Hektar (Ertrag). Da Range count auf 6 eingestellt ist,
ergeben sich finf Intervalle, die farblich dargestellt werden, und eine Farbe fiir die Werte, die auRerhalb der
Intervalle liegen. Der Ertrag wurde mit Hilfe der Beschriftung (Labels, S. 44) in die Fl&chen geschrieben.

Hinweis: Bei der Intervalldarstellung in der Spalte Label ist zu beachten, dass der maximale Wert nicht zum
Intervall gehért!

| Rendering | Scale | Colour Theming | Labels | Decorations
e
| ¥ Enable colour theming (| By Range

g —
| Attribute: |Eman ¥ | Range count: _‘_l:.| Rwu(ntolou
(Colour Scheme | BuGn (ColorBrewer) e
. Er— -0/
file Edit View Layer Tools Customize Window Help |
dd Qe @R A [e=QH [ Jpom
— 3
¥ GeoCity | — 75 oo B
ClBeschrebung |~ | — 1123~ - /
% [ Vegetation i y 4
B [v] Baeume = ——— /’ y
¢ [ Verkehr | b y
b Atiribites: Landwirtschant = o @ Yy /
| Landwirtschaft (6 Features) y
¢ @ |_[FiD_[Nukungsant [Flaeche [Ertrag y
| SR 11372 10
8] 86 Acker 9398 25
B 87 wald 10320 50
* Y gilial escerside 2952 125
B 89 Acker 11379 5
o] 80 Grinland 20895 40|
¥| FunkB
W ] Bauernhof
¢ ] Grundstuecke
] Wotngebiet L
] Stadtpark |
¢ v iLandwitschat | s .
10-25 2 10 ®,
2540 £ &
I 40- 50 E £
M 50 - 125 5
W 125- = f
O[] Gewerbegebiet = Parkaties
% [_] Feuchibiotop = g il
Lo [ 5| & /
[Number Selected: 0(0,0)0pts [0 MB Committed Me... | [63965.5, 51761.4)

Thematische Darstellung von Ertrag pro Hektar mit Beschriftung (Label).
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7 OpenJUMP 1.2 Tutorial (Grundlagen)

7.4 Beschriftung (Labels)

Die Attributwerte der Features kdnnen als Beschriftung dargestellt werden. In unserem Beispiel werden die
Strallen des Layers Strassen mit dem Attribut Name beschriftet. Die Positionierung der Texte ist abhangig
vom gewahlten Ausschnitt und ist nicht direkt beeinflussbar!

Tipp: Mdchte man Text an einer bestimmten Stelle platzieren, zeichnet man auf einem Hilfslayer an den Text-
positionen Hilfslinien mit den Textattributen. Die Darstellung der Hilfslinien kann mit der Rendering-Funktion
(Change Styles>Rendering, S. 39) ausgeschaltet werden, indem vor Line: das Hakchen entfernt wird.

Enable labeling: Text ein- und ausschalten.

Label attribute: Attribut, das dargestellt werden soll.

Vertical alignment (for points and lines): Vertikale Textausrichtung.

Horizontal alignment (for points and lines): Horizontale Textausrichtung.

Angle Attribute (Degrees): Textwinkel in grad in Abhangigkeit eines Attributs.

Height attribute: Texthéhe in Abhangigkeit eines Attributs.

Height: Texthéhe.

Scale labels with the zoom level: Schrifthbhe in Abhangigkeit des Zoom-Faktors.

Hide labels when: Scale is below 1:X Text ab gewahltem Mafstab ein- und ausblenden.

Hide overlapping labels: Uberlagernde Texte ein- und ausblenden. | Fonderng | Scoi [ Tolodt Tremg [ tabeie | Decorotons |
|v| Enable labelling
Label attribute: =I-Iame -
Vertical alignment (for points and lines): i\tmv the I.'lw [ ".

Horizontal alignment (Tor points and lines): |Center | ~

Angle Attribute (Degrees): (none) | v
Height attribute: |inone) |+
& OpenJump Haight: {20
File Edit View Layer Tools Customize Window Help [ ] Scale labels with the zoom level.
| e - : #| Hide labels when:
et Q{"} Q R e % Q a 6 m =& D E Scale is bel 1:|20000.0
e oW + {20000,
W GeoCity % [¥] Hide overlapping labels,
[ Working -
= change-color Change Font...
[ System ang ge |
¢ [ Sonstiges (] Draw outline (halo) around labets
[ GeoCityBeschr Outline widt
Beschreibung
7 [ Vegetation
= [ Bacume | Preview at current zoom level:
¥ IjVelKeH.l. Vor dem Acker
= ¥/ HalenStrasse
B v Strassen | ¥ r
Topographie 5 & =
# 3 Topoor ":m" - = |V Atributes: Strassen o @ B
= : = B Strassen (6 Features)
| Fuss = ¢/1_IFD Name Laenge
¢ [ Gebaeude 2 3 <] 44 Vor dem Acker 477
GebaeudePrival > 45 Landstrafie 325
™ GabaoudeGemel S Q= 46 Parkaliee 857
3 Parkay, @ >| 47 Am Kawerk 408
B L] Funka =/ 4aHafenstate 514
| FunkB b =| 49 Hinter den Hifen 440
W || Bavernhol
7 [ Grundstuecke a
_| Wohngehiet 5 4
| tadipark i Ly,
@ m |_|Landwirtschaft =
0 || Gewerbegebiet
5 L] Feuchtbiotop
¢ [ Abwasser b
Number Selected: 0(0,0)0pts 55 MB Committed Me... | [63998.5, 51799.7)

Beschriftung der StralBen von GeoCity mit Hilfe von Labels.

44 HCU Hamburg, Department Geomatik



Layerdarstellung (Styles) 7

7.5 Anfangs- und Endsymbol (Decorations)

Mit Hilfe von Decorations kann ein Anfangs- und Endsymbol einer Linie festgelegt werden. Die
ausgewahlten Symbole missen vom linken Teilfenster ins rechte Teilfenster Ubertragen werden, um zur
Anwendung zu kommen. Hier wurden die Gebaude des Gewerbegebietes beschriftet. Dazu wurde ein Layer
Beschreibung mit den Linien der Pfeile und den Beschreibungen angelegt. Es ist darauf zu achten, in welche
Richtung die Linien gezogen werden, weil es Start- und Endsymbole gibt. Die Startpunkte der Linien
bekommen hier ein Pfeilsymbol und die Endpunkte bekommen hier ein Federsymbol. In Kombination mit der
Beschriftung (Labels), kbnnen so Informationen zu den Gebauden dargestellt werden.

| Rendering | Scale | Colour Theming | Labels | Decorations

|— End.Arrow.0pen |~ End.Feathers

— End-Arrow-Solid ~— Start-Arrow-Solid-Narrow |
—= End-Arrow-Solid-Narrow

—o End.-Circle

== Middie-Arrow-Solid-Narmow

—— Segment Downhill Arrow Oy

=+ Segment Downhill Arrow S¢

= Segment Downhill Arrow S¢

LIA Segment Metrics

=~ Segment-Mid-Arrow-Open 1
-+ Segment.Mid-Arrow.Solid t d

= Seomtms ronsu [

File Edit View Layer Tools Customize Window Help :2:'::::'2::' €
dd QM @A EQ X ()i ] = @ | o stancircle
¥ GeoCity #— Start.Feathers
i CEm S = S 2| M Vertexindex
1 System ¥ Vertex XY
¢ []Senstiges Z VertexZ
[ ] GeoCityBeschr
v| Beschreibung
¢ [ Vegetation
B | Bacume | -
¢ [ Verkehr ) -
=[] HafenStrasse \ F [ —
W [ Strassen stadtweti® . f
? m”"ff”?:c . ______‘___‘___‘_—_iﬂiltjﬂider]‘rahn%
B [ Fuss | o \
¥ [ Gebacude ¥ Attributes: Beschreibung o° &' / & \
-t L Beschreibung (7 Features) | Y —
B (] GebaeudeGd | §| [ FID | Bemeriung & ‘ ¥
B [ FunkA 82 1 Einkaufszentrum LY
s S 4Mdargbe g
Q|5 swusmube .
W (]Bavernnof oy [ 3kanwerk 7
Pk | ARG
= Welmactielre =] a’éféﬁi@e%{f_'g"“"
- [ Landwirtschaft
O [v] Gewerbegebiet
7 [ Feuchibiotop
Lj.lhnaﬁsei B
Number Selected: 00,0]0pts |48 MB Commitied Me... | (64385, 51069.9)

Linien mit ,Start-Arrow-Solid-Narrow* und ,,End-Feathers“ kombiniert mit einer Beschriftung (Labels).
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8

8 Berechnungen

8.1 Flachen- und Langenberechnungen

OpenJUMP 1.2 Tutorial (Grundlagen)

Mit Tools>Analysis>Calculate Area and Length... kann der Flacheninhalt von Polygonen oder die Lénge

von Linienziigen auf einem Layer berechnet werden. Hierzu muss fur den Layer ein Attribut definiert sein, das

das Ergebnis der Flachen- oder Langenberechnung aufnehmen kann (S. 37). Um die Fldchen oder L&ngen

berechnen zu kénnen, muss der Layer editierbar sein! Im unteren Beispiel werden die Flachen der einzelnen

Grundstiicke des Layers Wohngebiet berechnet. In dem Dialogfenster wird der Layer, die Berechnungsart und

das Attribut fir das Ergebnis ausgewahit.

File Edit View Layer | [ools| Customize Window Help
idia Q)T (@ Queries '@l X ®e A e O = soom
Analysis ¥ Geometry Functions... -
b GeoCity | G » Spatial Join of Geometries... Gl
¥ LJ tupagi apie 1
|Teich | Wamp ¥ Union...
W [ Fuss Edit Geometry ¥ Union by attribute value... & Calculate Areas and Lengths
¢ ] Gebaeude oA b Overlay... —
& | Edt ¥ Join Spatially Layer | Wohngebiet |
B [ |Gebaeud( Generalization | Calculate Areas and Lengihs... | v| Calculate area
1 Measure inFeel | Planar Graph - T
W []FumkA bidhn 3 o Area attribute name  Vormame | v
] Funks L = Vorname
B [ | Bavernhof [] Calcutate length Wttt
7 [ Grundstuecke ngih atiribite name  [FSecHS
]
b= Attributes: Wohngebiet o @ X oK cancel
T Wohngebiet {14 Features)
T FID_|Vormame | Nachname |Flagche |
3 9ikara |Fall |~ 13800) |~ |
930t Fant 9037
= Q 94[Helmut__ |Helmchen | 3570
Q 95/Malte [Mller 2864
96iFrieda  |Mever 1733|
 CIHil & 97[Kay [Kaiman 1218
¥ |@] 9sjiens \Jensen 1606
99iMoritz |Moor 2256 |
100|Dieter |Dachs 1753
101 |Paule |Bchuster 1923
102|Stadt GeoCity 3789
103Gustay__ |Gans 2202| [
R4 ToulsH e =
04|Stadt GeoCi 4256
¢ CIRd ! oachy =
O[] Buffer-FunkA -
Number Selected: 0[0,0]0pts |56 MB Committed Me... | [64133.1, 51609)

Flachenberchnung fiir den editierbaren Layer ,Wohngebiet®.

Hinweis: Die Statistik-Funktionen (S. 47) bieten andere Mdéglichkeiten, Flachen und Léngen zu berechnen!

46

HCU Hamburg, Department Geomatik



Berechnungen

8.2 Statistiken

Mit Tools>QA>Layer Statistics konnen Statistiken bezilglich der Geometrien eines Layers angezeigt

werden (QA = Qualitats-Analyse). Dazu muss der Layer markiert und dann die Funktion aufgerufen werden.

Hinter Envelope stehen die minimalen und maximalen Koordinaten des Layers. Hinter # Features steht die

Anzahl der Features (hier 14 Grundstlicke). Die Tabelle zeigt die minimalen (Min), maximalen (Max),
durchschnittlichen (Avg) und gesamten (Total) Werte der Punkte (Pts), Lécher (Holes), Komponenten
(Components), Flachen (Area) und Langen (Length) an. In unserem Beispiel sehen wir, dass das kleinste
Grundstiick eine Flache von 1218 gm hat, die gréfite Flache 13800 gm und die Gesamtflache 53637 gm

betragt.

Hinweis: Die Dimension gm hé&ngt natlrlich von der Dimension der Zeicheneinheit ab. Da hier eine

Zeicheneinheit = 1 m ist, werden z.B. die Flachen in gm (Quadratmeter) angezeigt.

@ [ | Gebaeug( Generalization » Feature Statistics

&= openJump
File Edit View Layer | [ools| Customize Window Help
idia Q)T @ Queries weE N ree @ = = | N
p——— ADANSIS > ‘
¥ GeoCity . — -
[T o E . = e P
Teich Warp »
W [ Fuss | Edit Geometry »|
7 [ Gebaeude an ¥ validate Selected Layers...
i {5 ¥ Layer

B [ ] FunkA Measure In Feel | Calculate Geometry Differences...
] Funke T | Delete Empty Geometries in Selection
B [ | Bauernhof
7 [ Grundstuecke
\v| Wohngebiet
|| Stadtpark
& m || Landwirtschaft
0 [ | Gewerbegebiet
1 [] Feuchtbiotop
¢ ] Abwasser
[| AbwasserZufluss ¥ output o' @ [
(| AbwasserAbfiuss
# CJHiNsPunite Layer Statistics
W [ |HP_Achsen =
B | |HP_Gebaeude .
= ] HP_Grundstuecke Layer: Wohngebiet
B [ HP_Teich Envelope: Env[64240.7414 - 64543 1387, 51348 2227 . 51740.2141]
[ Raster # Features: 14
2 e Rk . M Max Avg Total
[ [ Buffer-FunkA -
Pls 5 ] 5.0 75
umber
Holes 0 0 0.0 0
Components 1 1 1.0 14
Area 1218.742823699722 | 13800 0608446256354 | 3831 257443767276 | 53637.60421274186
Length 142.57521967014167 | 545.7106771097697 | 246. 6889647 1318644 | 3453 6455059844103

i 1

Informationen tiber den Layer ,Wohngebiet".
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8 OpenJUMP 1.2 Tutorial (Grundlagen)

Mit Tools>QA>Feature Statistics kdnnen Informationen zu den einzelnen Features auf einem Layer
angezeigt werden. Hierbei wird eine neue Kategorie QA angelegt, unter der ein neuer Layer mit dem Namen

Statistics-Layername (hier Statistics-Wohngebiet) angelegt wird. Mit Wkann die Feature-Statistik angezeigt

werden. In unserem Beispiel sehen wir unter anderem die Flachen (area) und die Umfange (/ength) der
einzelnen Grundstiicke.

& OpenJUMP

File Edit View Layer |[ools Customize Window Help
g QY @ Querles Rl e A = 0O =——0—=suom
Analysis » =
b GeoC i
% Generate A i R i I:"__E
¢ ] Gebaeude Warp :
3l Edit »
& (] Gebaeud aA ¥ Validate Selected Layers...
- .j Funka | EdtAtiiibutes ¥ Layer Statistics
[Jrunks | Generalization | Esature Statistics
B [JBauermhe [easure nfeel | Calculate Geometry Differences..
i T T pelete Empty Geometries in Selection
Kategorie QA [T !
leg Q ¥ Statistics- Wohngebiet |
mit neu 4 3 Grumdstuocke |‘|
erstelltem Layer. v e
= > e B
& w []Landwirtschaf ___ Statistics-Wohngebiet (14 Features) _ - - — e
= @ [TFiD_TnPts [nHoles |ncomponents s | length tipe
od g [Em0 ] 1 13800.060846256354 545.7106771007687 Polygon
[ [feuchtbiotop | .= (8] 471 6 0 1 0037.289088360267 408.5704318504632 Palygon
§ CJ Abwasser Ql[m a2 5 0 1 3570207000340335 251.289296043883... Pohygon
= Zufh l_:‘_: 473 (F] 1] 1 2864.376022815006 218.604875131115... Polygon
'?!”“””' 9 @] 474 5 0 1 1732,0681004398188 173.482818005123... Polygon
| Abwasser AbThd h Di 475 5 o 1 1218.742823609722 142 575219679141 . Polygon
§ ] HitsPunkte 7@ 76 s 0 1 1606.8563598101977 162.177315458585_.. Polygon
W [ |HP_Achsen B] 477 6 0 1/2256,5618708800757 190.390101452694... Potygon
e gi 478 5 1] 1 1753.0386996100424 174.130061649269._.. Polygon
W |l P Getiaoude @ 473 6 0 1/1923.5541044851764 188.004630573700... Polygon
B [ HP_Grundstued D 480 5 0 1 3789.430120309582 266.1302962241567 Polygon
B [HP_Teich @] 481 5 0 122025705033001723 192.564183018680.. Polygon
[ Raster @] 482 5 0 1 4256600447954694 278 4402869355262 Polygon
¢ ClResul O] 483 5 0 1 3626.1562155003194 261 566312852299, Polygon
00 [ Buffer-FunkA -
Number Selected: 0(0,0)0pts 18 MB Committed Me... | [64134.7, 51751.7)

Fldche und Umfang der Features des Layers ,Wohngebiet*.
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Abfragen (Queries) 9

9 Abfragen (Queries)

9.1 Allgemeines

Uber Tools>Queries kénnen raumliche Abfragen oder Abfragen beziglich Attribute (Sachdaten) ausgefiihrt
werden. Wegen der Fille der Mdoglichkeiten, werden hier nur exemplarisch einige Abfragemdglichkeiten

vorgestellt. Weitere raumliche Analysen finden Sie unter Rdumliche Analysen, S. 52.

9.2 Réaumliche Abfragen (Spatial Query...)

Mit Tools>Queries>Spatial Query... konnen zwei Layer Uber eine Beziehung (Relation) miteinander
verknupft werden. In unserem Beispiel sollen alle bebauten Grundstiicke des Wohngebietes mit Eigentimern
gesucht werden, also alle Grundstiicke (Features) des Layers Wohngebiet, die Features vom Layer
GebaeudePrivat enthalten. Da Grundstiicke gesucht werden, muss im Dialog-Fenster hinter Source Layer
der Layer Wohngebiet ausgewahlt werden. Hinter Relation steht die VerknUpfung (hier contains, enthalten)
und hinter Mask Layer der Layer, mit dem der Source Layer verkniipft werden soll (hier GebaeudePrivat).
Als Ergebnis wird ein neuer Layer unter der Kategorie Result mit dem Namen SourcelLayer-Relation (hier
Wohngebiet-contains) angelegt. Die Attribute werden vom Source Layer ibernommen.

& Spatial Query

Finds the source Source Layer Wohngebiet [v]
Teatures which have a r -
& OpenJump given spatial Relation |contains |-

- relationship 1o some _—
File Edt View Layer |Tools| Customize Window Help feature in the mask Masklayer | | GeboeudePrivat  |w
] Queries * Spatial Query. | [ laver. L. SELECY Parameter
=0 -0 Q W G S ’l ST 1 a o O Source.’ FROM Source
W GeoCity £ =il JOIN Mask ON Source | Alow Duplicates in Result
T Gt ¥ Simple Query I <Relation> Mask)
£ = I | Complement Result
] Gebaeudy Warp A
B ] Gebaeu{ Edit Geometry » & Create a new layer for the results,
A 3
B || Funkh R Select features in the source layer.
Funk Edit Attributes  »
Generalization »
B [ | Bauernhg ; : : oK Cancel
v dc‘"nﬂs‘uwnﬂ Measure I:!.---. J L J
[¥] Wohngebiet
|| Stadipark
- o Ll
| 16| ¥ Attributes: Wohngebiet-contains - o @ [ e
|F B Wolingebiet.contains (9 Features) 3
¢ ] Abwasser f#|l_/FI0_[Vomame |MNachname |Flaeche f
AlB B 484 Helmut Halmchen 3570
ey B 485.Jens Jensen 1606
LA B 486 Frieda Meyer 1732
% [ HilfsPunkt Q 8| 487 Dieter Dachs 1753
" H 0| 488 Gustay Gans 2202
- . "H B 489 Motz Moor 2256
— B 490 Faule Schuster 1923
LamL B 491 Kay Kaiman 1218
B [ 8] 492 Malte Mller 2864
] Raster "
¢ [ Resunt 9'%
B | Wohngebiet.contains T
| Buffer-FunkA & ——Lamay, &
¢ CJoa 9
Statistics-Wohngebiet | v R
Number Selected: 0[0,010pts 59 MB Committed Me... | [64137.5,51625.3)

Alle bebauten Grundstiicke (dunkel) mit Eigentiimern auf dem Layer ,Wohngebiet-contains”.
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9

9.3 Abfragen nach Attributen (Attribute Query...)

OpenJUMP 1.2 Tutorial (Grundlagen)

Mit Tools>Queries>Attribute Query... kdnnen Features eines Layers Uber ihre Attributwerte ausgewahlt

werden. In unserem Beispiel sollen alle Grundstiicke, die gréf3er als 3000 gm sind, gesucht werden. Hinter

Source Layer wird der Layer ausgewahlt, der analysiert werden soll (hier Wohngebiet). Hinter Attribute wird

das Attribut fir den Vergleich ausgewahlt (hier Flaeche). Hinter Relation steht der Vergleichsoperator und

hinter Values steht der Wert, mit dem verglichen werden soll. Ist Create a new layer for the results

ausgewahlt, wird unter der Kategorie Result ein neuer Layer

mit dem Namen des Source Layers und dem

Vergleichsoperator angelegt (hier Wohngebiet->=). Mit Hilfe von Labels (S. 44) kénnen die Flachen dann mit

ihrer Gré3e beschriftet werden.
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Alle Grundstiicke des Wohngebiets, die 3000 qm und gréBer sind.
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Abfragen (Queries) 9

9.4 Einfache Abfragen (Simple Query)

Mit Tools>Queries>Simple Query kann der so genannte Query Builder aufgerufen werden. Hiermit kénnen
raumliche Abfragen und Abfragen nach Attributen durchgefiihrt werden. In unserem Beispiel wollen wir alle
Grundstiicke auf dem Layer Wohngebiet suchen, die der Stadt GeoCity gehoéren (Attribut Nachname). Unter
Layer wird der Layer ausgewahlt, auf dem die Abfrage ausgefiihrt werden soll. Unter Attribute wird das
entsprechende Attribut (hier Nachname) ausgewahlt. Unter Function wird die entsprechende Funktion flr
den Datentyp des Attributs ausgewahlt. Hier ist der Datentyp String und die Funktion trim eliminiert alle
Leerzeichen und Tabulatoren. Unter Operator wahlen wir equals, weil alle Nachnamen gesucht werden, die
gleich (equals) GeoCity sind (Value). Mit dem Knopf Valid wird die Abfrage ausgefiihrt. Wurde unter Results
Create a New Layer ausgewahlt, wird der Ergebnislayer unter der Kategorie Result angelegt (hier
Wohngebiet_GeoCity). Die Attribute des Ausgangslayers werden mit ibernommen.

- Query Builder
Ouery manager

| Case Sensitive __| Display the Table
| Sefect the Result

! Create a New Layer

file Edit View Layer |Tools| Customize Window Help
o Q{7 |@ Queres ¥ Spatial Query... @0 o @ O - == soom
Analysis ¥ Attribute Query... 3
§ I Verkehs | worp N
B [vistassen ey Goometry
[ | HafenSirs an »
g&m" Edit Attributes
4 CResul Generalization *
O [ utter.fu Measure in Feet
[ Wohngebiet.>= | \
" vl Wohngebiet_GeoCity ”
¢ [ Sonstiges | | " GeoCity
L] GeoCiy Attributes: Wohngebiet_GeoCity o~ @ gﬁ\ -
LIBescl 15 Wohngebiet_GeoCity (3 Features) 4 N
¢ CVegetation  |'g /| [FD [vomame |Nachname |Flasche _ / /
@ []Ba g[8 1028tac GeoCity 3789 " GeaCity
$- =] Topographie iB] 104 Stadt GeoCHy 4256 v,
1 Teich ||_:_- 105 Stadt GeoCity 3626
I
B [ [Fuss
¢ [ Gebaeude
[¥] GebaeudePrivat
B [ GebaeudeGewerbe |
B ] FunkA GeoCity
[ Funk8 “,
W [ Bauernhof <
¢ [ Grundstuecke % Ahallgg *
] Weohngebiet - f'
(| Stadipark - &
Number Selected: 0[0,0]0pts |58 MB Committed Me... | k64140, 51639.1)

Alle Grundstticke, die der Stadt GeoCity gehéren (hier schraffiert).
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10

10 Ra@umliche Analysen (Analysis)

10.1 Allgemeines

OpenJUMP 1.2 Tutorial (Grundlagen)

OpenJUMP verfligt Uber eine Vielzahl von raumlichen Analysemdglichkeiten, die Uber Tools>Analysis

aufgerufen werden kénnen:

Buffer (Saum, Distanzbereich, Zonen)

Schnittmenge (Intersect, Overlay)
Vereinigung (Union)

Differenz (A-B), (B-A), symmetrisch

Unter Abfragen (Queries) sind weitere Abfragemdglichkeiten beschrieben (S. 49).
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gl |q@ 6 Q e

File Edt View Layer Tools Customize Window Help

920 A=«

Ol =

¥ GeoCity

% [ Abwasser =
B [ | AbwasserAbfluss |
[ AtwasserZufluss
(= Working
] System
¢ [ Sonstiges
|| GeoCityBeschr
[_| Beschreibung |
7 [ Resun |
1 v| Wohngebiet.>= |
I lv| Wohngebiet-contains.
v| Buffer-Fluss

|| Buffer-FunkA-Difference (A-B)| 1
7 [] Buffer-FunkA-Difference (B-A)
|| Buffer-FunkA-Symmetric Diffe;
7 [ Vegetation
H v Baeumne
¢ [ Verkehr
=[] HafenStrasse
B [v|Strassen
¢ [ Topographie
v] Teich
B ¥|Fluss
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Number Selected: 0 [0, 0] 0 pis

59 MB Committed Me... |

{63744, 51619.4)

GeoCity wird analysiert.
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Raumliche Analysen (Analysis) 10

10.2 Puffer (Buffer)

10.2.1 Allgemeines

Mit Hilfe von Tools>Generate>Buffer... kann ein Puffer (Pufferzone) um alle Geometrien eines Layers ge-
legt werden. Es entstehen neue Flachen, die auf einem neuen Layer unter der Kategorie Result abgelegt
werden. Der neue Layer bekommt den Namen Buffer-SourcelLayer, wobei SourcelLayer der Layername des
Ausgangslayers ist (z.B. Buffer-Hafenstrasse). Bei einem Punkt entsteht z.B. nach dem ,Puffern” eine Kreis-
flache um den Punkt mit dem Radius des Pufferabstands (Buffer Distance). Ein Linienzug wird um einen
zu bestimmenden Abstand verbreitert und als neue Flache dargestellt. Ein Polygon wird um den Pufferab-
stand vergréRert. Die urspriingliche Geometrie wird nicht verandert! Die Puffer-Funktion bezieht sich in
OpenJUMP immer auf alle Geometrien, die auf dem Layer liegen. Die neue(n) Fldche(n) kann man fir weite-
re Analysen nutzen.

10.2.2 Puffer um einen Punkt

Die Klargruben im Stiden von GeoCity sind bei Windstille in einem Radius von ca. 300 m zu riechen. Welche
Bereiche der Stadt sind betroffen? Hierzu legen wir auf einen neuen Layer (HP_Klaergruben) zwei
Hilfspunkte in die Mitte der Klargruben und bilden Pufferzonen in einem Abstand (Buffer Distance) von 300
um die Punkte. Das Ergebnis steht auf dem Layer Buffer-HP_Klaergruben.

Layer = IFMW
pr— Buffer Distance S 3000
File Edit View Layer |Jools| Customize Window Help . End Cap Style |Round | |
idle QT @ Queries L L &0 ¢ Number of segments per circle quarter, | 16
= = Analysis B e -
GeoCity G ¥ Buffer.. i e i | Union
9 m Verkehr g ers all geometries
Warp Cormvex Hull on Layer... inthe input layer. v Heep Attributes
W [ Strassen ey Goometry 5 Create Thiessen Polygons
i L]HatenSty o M ComexHul | oK _gancel |
] Working Edit Attributes ¥ Random Triangles - -

System |
¢ g““u‘ Generalization ¥ Random Arrows
7 (] Bufter-Fu_Measure InFeet | [
(] Wohngebiet->=

Wohngebiet_GeoCity
7 v| Buffer-HP_Klaergruben
¢ [ Sonstiges
| GeoCityBeschr
|| Beschreibung
¢ [ Vegetation
B vl Bacume
¢ ] Topographie
[v] Teich
B || Fluss
7 [C] HiltsPunkte
B [ HP_Teich
B I HP_Grundstuecke
B [ | HP_Gebaeude
W [ |HP_Achsen
© ¥ HP_Hlaergruben
¢ [ Gebaeude
v| GebasudePrivat -

Number Selected: 0(0,0]0pts |98 MB Committed Me... [63694.4, 50910.1)

Hier stinkt es gewaltig!
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10 OpenJUMP 1.2 Tutorial (Grundlagen)
10.2.3 Puffer um einen Linienzug

Die HafenstralRe soll auf 20 m verbreitert werden. Dazu legen wir einen Buffer im Abstand von 10 um den Li-
nienzug der Stralle. Es entsteht ein neuer Layer (Buffer-Hafenstrasse) unter der Kategorie Result, auf dem
die verbreiterte HafenstralRe dargestellt wird. Im Buffer-Dialogfenster kann unter End Cap Style die Ausge-
staltung der Anfangs-/Endpunkte eingestellt werden (Round, Square, Butt). Ist Keep Attributes gewahlt, wer-
den die Attribute der Features des Ausgangslayers auf die Buffer-Features ibertragen.

Round Square Butt

& opentump
File Edit View Layer |Iools| Customize Window Help

e [ @ Queries L E L 90N @ @ 0O =————{— 200m

Analysis [
¥ GeoCity z Y Buffer... : i oo @
] Working Warp » Corvex Hull on Layer...

1 5 Sotes ki S e i — =
[ Geocitys] 2P TR Layer | [l HafenStrasse |
| Beschred Efit Attributes » Random Triangles . : -
a 3

¢ £ Vegetation Generalization ¥  F Random Arrows R “ p— Buffer Distance — 100

B [ | Bacume | Measureln Feet . End Cap Style Round |~
¢ CIVerkehr | ! s Number of segments per circle quarter, [ROUNd

1" vl HafenStrasse e Square

1 | (] Unian Butt

W [ |strassen Buffers all gometries
7 ] Result -~ in the input layer. ! Keep Attributes

M [ Buffer-HafenSirasse.Butt h@b

8 1 - Q“ ;_— -

| ! :Bul'lol HafenStrasse.Square ?‘é L OK L E_an:al "

B[] Buffer-HafenStrasse

O ] Buffer-FunkA

% [ Topographie ;
[] Teich & opensuwp
W [ |Fuss File Edit View Layer Tools Customize Window Help
7 ClGebasude QM@ AN ¢ Q9QE L 90 A @™ @& 5 ——O 2om
1L4] "
. Sl ; : i A ]
B[] Funka gxw o
S e
L :_J. ::::mu {f gsvm’llmn
¢ [ Grundstuecke _LJ_GwCIvBesclu
v] Wotingebiet ] Beschreibung
$ =
B[] Baeume
¢ [ Verkehr
7 [¥] HafenStrasse
W [ strassen
¢ CIResur py
M [ Buffer-HatenSirasse. Butt é@
=[] Buffer-HafenSirasse.Square Q&‘
"I v Buffer HafenStrasse
[ Teich I
B []FAuss
¢ (] Gebaeude

v| GebaeudePrivat
B [ GebaeudeGewerbe
B[] FunkA
© LIFunkB
B | Bauernhol
¢ [ Grundstuecke |
v Wohngebiet |~

Number Selected: 0[0,0]0pts |51 MB Committed Me... | {64199, 51445.5)

Die verbreiterte Hafenstral3e.
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Raumliche Analysen (Analysis)

10.2.4 Puffer um ein Polygon

10

Der Teich im Stadtpark soll um 25 m verbreitert werden. Welche Bdume mussen gefallt werden? Die neue

Pufferzone (Buffer-Teich) kann zu weiteren Verschneidungen mit dem Layer der Bdume (Baeume) genutzt

werden. Mit Tools>Analysis>Overlay... kénnen die Bdume gefunden werden, die dem neuen Teich weichen
missten (S. 56).

Der verbreiterte Teich im Stadtpark.

HCU Hamburg, Department Geomatik
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(1 iv] Buffer-Teich ' b
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10 OpenJUMP 1.2 Tutorial (Grundlagen)

10.3 Schnittmenge (Overlay)

Mit Tools>Analysis>Overlay... wird die Schnittmenge zweier (oder mehrerer) Geometrien bestimmt. Wir
kénnen jetzt in unserem Beispiel ,Hafenstralenverbreiterung® (siehe Puffer um einen Linienzug, S. 54) die
Buffer-Flache mit den Grundstliicken des Wohngebietes (Wohngebiet) verschneiden. Die Schnittmenge wird
unter der Kategorie Result auf einen neuen Layer (Overlay) gelegt. Er zeigt uns die Teile der Grundstiicke,
die fur die Erweiterung bendétigt werden. Mit dem View / Edit Attributes Knopf {l

Eigentimer sehen, die von der Baumalinahme betroffen sind. Dazu muss in dem Overlay-Dialogfenster

kann man dann z.B. alle

Transfer attributes from first layer markiert sein.

& OpenJump
File Edit View Layer |Iools| Customize Window Help
idlio Q&) (@ Queries | S [}_ﬂﬂ_ fau] 0O = — sum
Analysis ¥ Geometry Functions... 1
¥ GeoCity G »| Spatial Join of | o @
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m|
¢ ﬁwwa;lm Generalization | Calculate Areas and Lengiis..
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[ [ Buffer-HafenStrasse
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e ? |FID_|[vomame |Nachname | Flaecne i
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Schnittmenge (braune Flédchen) aus ,Wohngebiet” und ,Buffer-HafenStrasse”.
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Raumliche Analysen (Analysis) 10

10.4 Vereinigungsmenge (Union)

Mit Tools>Analysis>Union... kénnen Geometrien gleichen Typs (Point, Linestring, Polygon) zu einer
Geometrie (Multipoint, Multlinestring, Multipolygon) zusammengefasst (vereinigt) werden. Es ist wichtig, dass
auf dem Layer, dessen Geometrien zusammengefasst werden sollen (Source Layer), nur Geometrien von
einem Typ existieren! Die neue Geometrie wird unter der Kategorie Result auf einem neuen Layer Union
dargestellt. In unserem Beispiel ,Hafenstrallenverbreiterung” mdéchten wir fir eine Kostenkalkulation die
Gesamtflache aller Teilflachen berechnen, die auf dem Layer Overlay liegen (S. 56), also von unseren
betroffenen Grundstiicken. Hierzu wenden wir die Funktion Union auf den Layer Overlay an. Ein neuer Layer
Union wird unter der Kategorie Result von der Funktion erstellt. Zur Berechnung der Flache wird das Schema
um das Attribut Flaeche erweitert (S. 37).

Mit der Funktion Analysis>Calculate Areas and Lengths... (S. 46) kann dann die Gesamtflache berechnet

werden. Hierfir muss der Layer Union editierbar sein.

File Edit View Layer [ools| Customnize Window Help
e Q& (@ Queries ’|.._.a__ LBl s A o e O = L 200m
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LI Teich Edit Attributes ¥ Join Attributes Spatially
B [ Fuss Generalization » Calculate Areas and Lengths...
% [ Resuh Measure InFeel | Planar Graph
alird [
| Overlay
O [ Buffer-FunkA - —
| Buffer-HafenStrasse | Creates a new layer Source Layer | [ Overlay |
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¢ [ Gebaeude all the features in the
|| GebaeudePrivat nput layer,
B[] GebacudeGewerbe 3889 .
B [ |FunkA - oK ] Cancel |
Funkg ¥ Atributes: Union o 27 B3
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0 [ Gewerbegshiet ‘ [Wacr] || s1a02.5495, 4274.9405 Multipolygon
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Ab "
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Number Selected: 0(0,010pts 69 MB Committed Me... | [64333.8, 51651.2)

Zusammengefasste Flachen der Teilgrundstiicke auf dem Layer ,Union”.
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10 OpenJUMP 1.2 Tutorial (Grundlagen)

10.5 Geometrische Funktionen (Geometry Functions)

10.5.1 Schnittmenge (Intersection)

Mit Tools>Analysis>Geometry Functions...>Intersection kann die Schnittmenge zweier Layer gebildet
werden (Source und Mask). Im Gegensatz zu Tools>Analysis>Overlay, darf der Mask-Layer nur eine
Geometrie enthalten. Falls es eine Lésung gibt, wird ein neuer Layer unter der Kategorie Result angelegt. Die
Attribute des Source-Layers werden auf den Ergebnislayer Gbertragen. Wir méchten in unserem Beispiel alle
Baume herausfinden, die im Stadtpark von GeoCity stehen. Als Source-Layer wahlen wir Baeume und als
Mask-Layer Stadtpark. Der Ergebnislayer Baeume-Intersection enthalt nach Ausfiihrung der Funktion

Intersection nur die Baume mit Attributen, die im Stadtpark stehen.

File Edit View Layer |Jools Customize Window Help
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Nur die B&ume im Stadtpark auf dem Layer Baeume-Intersection.
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Raumliche Analysen (Analysis)

10.5.2 Vereinigungsmenge (Union)

10

Mit Tools>Analysis>Geometry Functions...>Union kénnen, im Gegensatz zu Tools>Analysis>Union, zwei
Layer vereinigt werden. Der Source-Layer kann n Features enthalten, der Mask-Layer nur ein Feature oder

Item. Als Ergebnis wird jedes Feature des Source-Layers mit der Geometrie des Mask-Layers vereinigt, so

dass wieder n Features mit den Attributen des Source-Layers entstehen. In unserem Beispiel sehen wir
einen Teil des Abwassersystems von GeoCity. Auf dem Layer Zufluss befinden sich 3 Features fur den
Zufluss zur Abwasserleitung. Auf dem Layer Abfluss befindet sich die Abflussleitung. Vereinigen wir beide
Layer, entsteht ein neuer Layer mit 3 Features unter der Kategorie Result. Jetzt kann z.B. die Gesamtlange

von Zufluss und Abfluss berechnet werden (S. 46).

& OpenJUMP

File Edit View Layer |Jools| Customize Window  Help
'@l Blxsa @A o e

£ [ Buffer-FunkA

[ [] Buffer-HafenSirasse

|| Baeume-Intersection

o |

(]

'—Q-—-sonm

Computes a geometric
Tunction on features in
the Source layer,
Geometry can be
saved to a new layer,
updated in place, or

i

adllg QQ‘") ‘A Queries
> ooty Bnalsis ¥ Geomelry Funcions...
TR G ¥ Spatial Join of Geometries...
7 [ Gebaeude Warp ¥ Union...
[¥| Gebaeud( Edit Geometry *| Union by atiribute value...
W |v] Gebaeud QA b Overlay...
B [ FunkA | Edit Attributes ) Join Attributes Spatially
] FumkB Generalization *| Calculate Areas and Lengihs..
B (¥ Baverphq Measure inFeel | Planar Graph
b e b |

added to the Source
| layer. Binary

[Z] 557 Zufluss
| 558 Zufluss
=] 559 Zufluss

s
8

take a mask feature
as their second
operand.

- Geometry Functions

Function  |Union
Parameter
S

[ ] Use selected features only.
‘@ Create new layer for resull.
) Update Source features with resull.
) Add result to Source layer.

o[ gance |

L

-

Nach Berechnung!

% [ Resuh
W v| AbwasserZufluss-Union
[ [] Buffer-HafenStrasse | F
—
EJ W Ak Zufluss-Union : o g ‘
. - B AbwasserZufluss.-Union (3 Features) T =
¢ CQHinsPY @) TFID [Bezeichnung [Lasnge | ge | NeueBezeichnung |
[ | 's' 35| 1018 Zufluss 158 410 Zufluss + Abfluss
= % 1019 Zufluss 122 374 Zufluss + Abfluss .
= $#1 1020 Zufluss 208 461 Zufluss + Abfluss .
3 8
] T
[ Raster = o

¢ [ Grundstuecke duflysg
[ Wohngebiet M
[ Stadtpark
e m || Landwirtschaft
O [ ] Gewerbegebiet
7 [] Feuchtbiotop —
¢ [ Abwasser ¥ Attributes: Abwasserbfluss o @
] AbwasserZufluss B AbwasserAbfluss (1Feature) |
B v AbwasserAbfluss #|}_/FID_|Bezeichnung [Laenge |
¢ [T HiltsPunkte 3 L? 556 Abfluss 251
H | |HP_Achsen
B [ ]HP_Gebaeude
B [ HP_Grundstuecke
W [ HP_Teich
[ Raster -
[Number Selected: 1[156.5, 25.3] . 50 MB Committed Me... | [63753.9, 51632.4) I —=—y
Rt
v| GebasudeGewerbe
FunkA
(] Funks
B [v| Bauernhof
% [ Grundstuecke
(] Wohngebiet g
[ stadtpark g\
& = []Landwirtschaft H b4 |
[ [ Gewerbegebiet %
™ [] Feuchtbiotop = @
¢ [ Abwasser L
= [ AvwasserZufluss B
B [ | AbwasserAbfluss

Number Selected: 1[170.8, 244] .. [55 MB Committed Me... |

[64255.1, 51631.4)

Die Vereinigungen von Zufluss und Abfluss sind auf dem Layer AbwasserZufluss-Union zusammengefasst.
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10.5.3 Differenzen (Difference)

Mit Tools>Analysis>Geometry Functions... kbnnen unter anderem die Funktionen Difference (A - B, B - A)
und die Symmetrische Differenz ausgefihrt werden. Diese Funktionen beziehen sich auf zwei Layer (Source
und Mask) mit jeweils einem Feature. Bei der Differenz A - B wird von der Flache A die Flache B
sherausgeschnitten und eine neue Flache auf einem neuen Layer gebildet, falls sich die Flachen
Uberschneiden (gilt sinngemaR auch fiir B - A). Bei der Symmetrischen Differenz wird die Flache auf Layer A
mit der Flache auf Layer B zusammengefasst (Union) und die Uberlappende Flache herausgeschnitten. Auch

hier wird eine neue Flache auf einem neuen Layer erzeugt.

In unserem Beispiel hat Radio-GeoCity zwei neue Sendemasten bekommen (FunkA und FunkB). Bei der
Uberlagerung der Funkwellen entstehen Interferenzen, die zu Stérungen des Empfangs fiihren kénnten. Wir
modchten folgendes herausfinden:

1. Welches Gebiet wird durch FunkA stérungsfrei abgedeckt?
2. Welches Gebiet wird durch FunkB stérungsfrei abgedeckt?
3. Welches Gebiet hat guten Empfang?

File Edit View Layer Tools Customize Window Help

i)l g Q{"? Q Q; o Q 96 A @ @ O = == 1km

W GeoCity o o
Sy i é : SR = ik = A bt
| Buffer-Funka
! Buffer-Funke
= Working
[ System
¢ [ Sonstiges
[ GeoCityBeschr
|| Beschreibung

7 []Vegetation FunkMast-8
B |v|Baeume |
¢ [ Verkehr ¢

|| HafenSirasse
W v]Strassen
# ] Topographie
v Telch
B |v|Fuss
¢ [ Gebasude
V] GebaeudePrivat | | ; 3
B v| GebasudeGewerbe - \
B [k —/[ B8\
] FunkB ® = =
B [v] Bauernhof R ® &
¢ ] Grundstuecke
[¥| Wohngebiet
| Stadtpark
o o lv|Landwirtschaft -

Number Selected: 0(0,010pts 89 MB Committed Me... | [63830.1, 51847.3)

Radio-GeoCity mit zwei neuen Funkmasten.
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10

Die erste Frage kénnen wir dadurch beantworten, dass wir die Differenz A - B mit den Layern Buffer-FunkA

und Buffer-FunkB bilden. Dazu wahlen wir im Dialogfenster Geometry Functions fur Source Buffer-FunkA

und fur Mask Buffer-FunkB. Als Funktion (Function) wahlen wir Difference (A-B), also Source minus Mask.

Das Ergebnis steht unter der Kategorie Result auf dem Layer Source-Function, also auf dem Layer

Buffer-FunkA-Difference (A-B). Die zweite Frage kann mit Differenz B — A gel6st werden.

& opensump
File Edt View Layer Jools| Customize Window Help
e Q@ @ aees  c@E Bl ®a @ o —
~ - Analysis * Geometry Functions... & Geometry Functions
GeoCity G ¥ Spatial Join of = : | — | .
Worl omputes a geometric . Source Buffer-FunkA -
gw? Warp oo Tunction on features in = — :
¢ O3 Sonstiges Edit Geometry * Upion by atiribute value... the Source layer. Function  Difference (A-B) s
Clceocuys| b Overlay... Geometry can be P raca
= | Edit ¥ Join Spatially savedto a new layer, —————— 4
=i 3 e updatedinplace,of | mask | [ Buffer.FunkB [~
% CJResul Generalization » Calculate Areas and Lengths.. added to the Source | Bl
O[] Butter-Fu MeasureinFeet | Planar Graph layer. Binary (] Use selected features only.
e 7 Tl geometric functions
L] ButTer-Funkh take a mask feature ® Create new layer for result.
v Buffer-FunkA-Difference (A-B) i 3 N astheir second E
¢ [ Vegetation ) / operand. ! Update Source Teatures with result,
¥| Baeume ) Add result to Source layer.
¢ [ Verkehr -
I [] HafenStrasse ok || cancel
B [v|Strassen - - ——— -
# (= Topographie r Stactpari
¥| Teich L /I
B [¥|Fluss —— - ik
= F fllnl'ﬂ_llsi-a
—// % ‘\\ .l
A .
[v| Funk@ [ ] ._
B [v| Bauernhof
7 [ Grundstuecke
[v| Wohngebiet
¥] Stadtpark =
[Number Selected: 0(0,0]0pts (106 MB Committed M... | [63682.8, 51530.9)
Stérungsfreier Empfang durch FunkA (Differenz A-B)
& opensump
File Edit View Layer Tools Customize Window Help
do QT @R e=2QH B @0 A = «r O ———0— 1m
b GeoCity oo @
[ Working i =
[ System
¢ [ Sonstiges
[ ] GeoCityBeschr
|| Beschreibung
¢ ] Resunt /
O[] Buffer-FunkB f
(] Buffer-FunkA
[_| Buffer.FunkA-Difference (A-B) -
vl Buffer-FunkA-Difference (B-A)
7 [ Vegetation
il Geometry Functions El
Computes a geometric  Source | I Buffer-FunkA |v|
Tunction on features in _ - —
the Source layer. Function  Difference (B-A) >
Geometry can be
saved to a new layer, ERHmatar ——
updatedinplace,of | Mask | [l Buffer-Funke [=]
added to the Source -
layer. Binary [ Use selected features only.
geometric functions
take a mask feature ‘@ Create new layer for result.
as their second -
operand. L Update Source features with result,
) Add result to Source kayer.
ok || cancel :
T Number Selected: 0[0,0]0pts  [120 MB Committed M... | [64217.6, 51997.9)
Stérungsfreier Empfang durch FunkB (Differenz B-A)
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Die dritte Frage konnen wir dadurch beantworten, dass wird die Symmetrische Differenz zwischen
Buffer-FunkA und Buffer-FunkB bilden. Leider missen wir feststellen, dass die Anwohner im Wohngebiet um

die Hafenstralle méglicherweise schlechten Empfang haben. Mit OpenJUMP ware das nicht passiert :-)

il Geometry Functions x|
Computes ageometric | Source i I Buffer-FunkA I"l
Tfunction on features in T T T =
the Source layer. Function  Symmetric Difference -
Geomelry can be
saved to a new layer, PnaORE -
updated in place, or Mask | ] Buffer.FunkB |=|
added to the Source -
layer. Binary [ | Use selected features only.
geometric functions
take a mask feature '@ Create new layer for result.
as their second -
operand. L Update Source features with result,
: result to Source layer.
File Edit View Layer |Jools| Customize Window Help e
T Q@ 4 Queries ’Eﬁ__@E N [nal i I [ oK Jl Cancel
[*S 3 Analysis 'I Geometry Functions... d L J
GeoCity G » Spatial Join of ! x i _ =
] Working Warp » Union...
] System Edit Geometry | Union by atiribute value...
¢ [ Senstiges i .
[ Geociys, 2 g
0l o Edit ¥ Join Spatially
¢ CRes I._ Generalization | Calculate Areas and Lengths..
1 [ Buffer.fu Measure lnFeet | Planar Graph
[ Buffer-FunkA | \
(| Buffer-FunkA.-Difference (A-B) : FunkMast-B
= L] Buffer-FunkA.-Difference (B-A)
| Bufer-FunkA f
§ [ Vegetation B ] ’
B [v] Basume [ |7 »
¥ Ewlfte_n_t_ S ey, .
I :_.iHaienStrasse y A
| v]Strassen
T aphie E
= e s FuinkMast. A
¥ Teich .
B [¥|Fluss
¢ [ Gebaeude
lv| GebaeudePrivat
B [v|GebasudeGewerbe
B (] FunkA
1] FunkB
W [v] Bauernhof |
7 [ Grundstuecke Bd
Number Selected: 0(0,0)0pts (136 MB Committed M... | [63737.4, 51636.4)

Guter Empfang im blauen Gebiet (Symmetrische Differenz).
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11 Anbindung an eine PostgreSQL/PostGIS Datenbank

Mit einem Plugin kann OpenJUMP Tabellen (Relationen) und Sichten (Views) einer PostgreSQL/PostGIS

Datenbank lesen und schreiben (nur Tabellen). PostgreSQL (http://www.postgresql.org/) ist ein

Objekrelationales Datenbankverwaltungssystem (ORDBMS), zu dem es eine sogenannte PostGIS-
Erweiterung gibt (http://postgis.refractions.net/). Mit Hilfe dieser Erweiterung kénnen Geometrien und
Attributwerte in Relationen (Tabellen) gespeichert und gelesen werden. Um in OpenJUMP mit PostGIS
arbeiten zu kdénnen, bendtigen wir einen JDBC-PostgreSQL-Treiber (JDBC=Java DataBase Connectivity)
und ein OpenJUMP Plugin. Den neusten JDBC-PostgreSQL-Treiber (z.B. postgresql-8.3.603.jdc3.jar)
erhalt man von der PostgreSQL-Homepage http://www.postgresql.org/. Der Treiber muss in das ...\lib\ext

Verzeichnis der JavaRuntimeEnviroment kopiert werden (z.B. C:\Programme\Javal\jre1.5.0_09\lib\ext).

Das OpenJUMP Plugin (z.B. JumpPostGIS61106B.jar) erhalt man von der OpenJUMP Downloadseite
http://sourceforge.net/project/showfiles.php?group_id=118054. Es muss in das OpenJUMP Plugin-
Verzeichnis ..\lib\ext kopiert werden. Das Plugin-Verzeichnis liegt im Installations-Verzeichnis von
OpenJUMP, z.B. C:\Programme\OpenJUMP\lib\ext. Um eine Verbindung mit einem PostgreSQL/PostGIS

Server aufnehmen zu kénnen, bendtigt man folgende Informationen:

+ Die IP-Adresse des PostgreSQL-Servers (Server).
+ Die Portnummer (Port, normalerweise 5432).

« Den Datenbanknamen (Database).

« Den Tabellennamen (Table).

- Den Benutzernamen und das Passwort (Username, Password).

Mit dem Programm pgAdmin Ill, das mit PostgreSQL installiert wird, kann die Datenbank administriert und
z.B. Tabellen angesehen werden (siehe auch PostGIS-

4% pgAdmin 11l
File Edt Yiew Took Help Tutorial (Grundlagen),
P Ay A . (| | @ | ] . . .
: ;3 sh O | = (= = /,(/‘ " http://openjump.org/wiki/show/Documentation).
Object browser
db_s1234567
# T Casts (259)
+ Languages (1)
= @ schemas (5)
File Edt ‘iew Help
A @ [ § FlNolimit  a
oid bezeichnung laenge geometry
text integer geometry
1 625015 Zufluss 158 SRID=-1;LINESTRING(64150 51390,64070 51400,63993,545302 51415.29094)
2 625016 2ufluss 122 SRID=-1;LINESTRING(63871.763437018 51428,2825935641,63930. 125029387 51425.8166107879,63993.545302 51415.29094)
3 625017 Zufluss 209 SRID=-1;LINESTRING{£4001.26707 51624.129032,63987.600401 51529.186559,63993.545302 51415.29094)
*
+ “&% Operators (13)
+ & Operator Classes (2)
& Sequences (0)
= 7 Tables (115)
CRE abwasseraufiuss |
+ [ b_berineralles
# [ basume

Tabelle mit Geometriespalte, dargestellt mit pgAdmin Ill.
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11.1 Tabelle schreiben

Mit Rechtsklick auf einen Layer und Save Dataset As... kann ein Layer in die Datenbank geschrieben werden.
Der Name des Layers steht nicht automatisch hinter Table:, sondern muss eingegeben werden. Unter
Select Save Method: kann New Table, Overwrite oder Insert ausgewahlt werden. Mit New Table wird eine
neue Tabelle in der Datenbank angelegt. Existiert bereits eine Tabelle gleichen Namens, kann sie nach
Abfrage geléscht werden. Diese Funktion wird meist dazu benutzt, wenn das Schema des Layers in
OpenJUMP geandert wurde (S. 37), oder wenn der SRID-Wert mit Layer>Change SRID geandert wurde. Mit
Overwrite kann eine bestehende Tabelle Uberschrieben werden, ohne dass sich mdgliche Neben-
bedingungen (Constraints) der Tabelle verdndern. Es wird nur der Tabelleninhalt geléscht und neu
geschrieben, aber nicht das Tabellenschema verandert. Mit dieser Funktion kann auch eine neue Tabelle
angelegt werden. Mit Insert werden nur die Datensdtze verdndert, die mit einem eindeutigen Schlissel
identifiziert werden kdnnen. Das Attribut (Spaltenname) dieses Schlussels wird hinter Unique Column:
eingegeben. Mit dieser Funktion kénnen Datensétze einer bestehenden Tabelle zugefligt werden, oder
bestehende Datensétze verandert werden.

Hinweis: Wird eine bestehende Tabelle mit New Table oder Overwrite geléscht, darf sie nicht vorher in einer

Sicht (View) angesprochen werden, sonst kommt es zu einer Fehlermeldung!

& Save Dataset As EJ

Select Save Method:

Now Table

Orverwrites an existing PostGiS-Table and keaps the table CONSTRAINTS
E(}penJUMF‘ & Overwrite

File Edit View Layer Tools Customize Window Help insert
do QM @ UANE QB BV @O A = | e conm

W GeoCity
% [ Abwasser Lo
B | | AbwasserAbfluss

] Worki L AbwasserZulluss
S . i | 2 s 345 A ufluss
7 System . Editable Database: db_s1234567 | Table: [atwasserZutuss
¢ [ Sonstiges ¥ [} Selectable | Usermname: 51234567 s ———

] GeoCityBaschn Layer Properties...
Beschreibung , Zoom To Layer

Server: larzan Port: |5432

¢ [ Result &3 Change Styles...
Buffer-FunkB Copy Styles | [
B e ran nde Shtia Format: |PostGIS Table |~
|Buffer-FunkA-L G yiew | Edit Attributes Fen

Buffer FunkA.[ OK (GML 2.0
@view /Edit Schema [ T B
mage Layer Manager (Test

[ ] Buffer-FunkA-$
¢ [ Vegetation
¥ Baeume
¢ [ Verkehr

Save legend. iz \

] Save Selected Datasets i
HafenStrasse | bt | I TR

B v|Strassen i Emnmm —___ ‘ ‘

% [ Topographie Rename Selected Layer | / \
lei eich I Move Layer Up a0 e

| v Fluss fove Layer Down Vil s ® &
¢ ] Gebaeude I 1
Cut Sedected L s :
| GebaeudePrivi 4 o
Copy Selected Layers

B v GebaeudeGew % Re B
Move: £3
B || FunkA Sl

-

Add Hew Featunes.

,0]0pts (143 MB Committed M... [63792.2, 51660.8)

Der Layer ,AbwasserZufluss* wird in eine PostGIS Tabelle der Datenbank ,db_s1234567“ geschrieben.
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11.2 Tabelle oder Sicht (View) lesen

11

Mit Rechtsklick auf die Kategorie, unter der die Daten liegen sollen, und dann Load Dataset(s)... kann eine
Tabelle oder eine Sicht (View) gelesen und dargestellt werden.

Dazu muss hinter Format: PostGIS Table eingestellt werden. Die Tabelle wird dann in OpenJUMP auf
einem Layer dargestellt, der den Namen der Tabelle hat. Besteht bereits ein Layer mit dem Namen der

Tabelle, wird der neue Layer umbenannt.

l.do%@@ Q e

il Load Dataset(s)

Server: larzan
&= OpenJump =
Database: db_s1234567

File Edt View Layer Tools Customize Window Help

S Username: (51234567

¥ GeoCity

9 Dw'“'_'_:_.n;ws_gg o |

Port: |5432

Table: AbwasserZufluss

Password: sssssss

4
A
{

(] Workin

l Add A New Layer
o Open...

¢ [ Sonstig
.
¢ ClResun |

Y
Y
- |

[ System

| ¥ 3 Set Category Visibility...

efbLoad Dataset(s)...

Add Datastore Layer...

Add a WMS Query...
Add Image Layer (Test, ECW DLLs deactivaled.)...

Format: |PostGIS Table |~
JUMP GML

L [GML 2.0

{FME GML

Remove Selected Categories

+ Move Category To Top...
+ Move Category One Up...
¥ Move Category One Down...

» Stadipark «

¥ I'_‘I\fe;e!fﬂ; & Move Category To Bottom...
¢ [ Verkeh Paste raster layer...
® Add pew raster layer...
B v Strassen E|
¢ 1 Topographie
v Teich
B v Fuss
¢ ] Gehaeude
[¥] GebaeudePrivat
B [v| GebaeudeGewerbe|
B[] FunkA |~

CIEN
LB

Number Selected: 0 [0, 0] 0 pis [122 MB Committed M... |

[63799.9, 51648.6)

Die PostGIS Tabelle ,AbwasserZufluss” der Datenbank ,db_s1234567" wird gelesen.
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12 Drucken

In OpenJUMP st es nicht mdglich, die dargestellte Grafik direkt zu drucken. Die Grafik kann aber im Raster-
(PNG, JPEG) oder Vektor-Format (Scalable Vector Graphics, SVG) in eine Datei gespeichert - und mit einem
geeigneten Programm (z.B. PhotoFiltre http://www.photofiltre.com bzw. Inkscape http:/www.inkscape.org)

ausgedruckt werden. Hierbei ist das Vektorformat SVG dem Rasterformat vorzuziehen, weil es besser skalier-
bar ist.

Mit ,File>Save Image in SVG Format“ wird die Grafik des Projekts im SVG-Format gespeichert. Hierbei

werden nur die Layer gespeichert, die auch eingeschaltet sind. Mit dem Open Source Programm Inkscape
kann dann z.B. die Datei bearbeitet und gedruckt werden.

“ GeoCity.svg - Inkscape EI@@
Datei Bearbeiten Ansicht Ebene Objekt Pfad Text Hilfe

DpEE PP ¢ B4¥D QA =XX @@ 0A®: XQ
2ead UAPN foaofme | owlmal e [|» v| [W[EE

;.I.I-I- .:rllul-I.l.l;....]l-I-I-I‘I;I-I-l.I.I- 3‘."’!.1.I.I.I.'T..F.I-I.I<III.-‘-;I.I.lrl.Ii?.r.l:.Y-!-I.II:\.‘.IE-I.I- Q

‘ | I

NEDPDNSOROEAP Al
\ |

£ >
3% |5 11014537124 & o | (Wurzel) B Alt: Verdeckte Objekte auswahlen. Ausgewdhites Objekt verschieben

GeoCity als Grafik in Inkscape.
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13 Glossar
CRS: Coordiante Reference System

EPSG: European Petroleum Survey Group; heute OGP (Oil & Gas Producers) Surveying & Positioning
Committee. www.epsg.org

Das Oil & Gas Producers Surveying and Positioning Committee pflegt und veréffentlicht Parameter und Be-
schreibungen fiir Koordinatenreferenzsysteme. Diese Parameter werden unter einer Kennung zusammenge-
fasst, dem Spatial Reference System Identifier (SRID). Diese Kennungen werden z.B. in OGC konformen
Diensten (z.B. WMS) und in PostGIS verwendet und ausgewertet.

(Siehe auch OGC: ,Coordinate Transformation Services®).

Beispiel: EPSG: 4326 = Geografische Koordinaten im WGS84 Bezugssystem
EPSG: 31466 = GauR-Kriiger, 2. Streifen
EPSG: 31467 = Gau3-Kriiger, 3. Streifen
EPSG: 31468 = GaulR-Kriiger, 4. Streifen

Die entsprechenden Dateien mit den Datensatzen (EPSG geodetic parameter dataset) kbnnen von der
Seite http://www.epsg.org/ geladen werden.

Feature (Objekt):
e Features sind abstrahierte Objekte der realen Welt. Zum Beispiel werden Straf3en als Linienziige,
Gebéude als Flachen oder Badume als Punkte abstrahiert und dargestellt.
In OpenJUMP hat jedes Feature ein rdumliches Attribut (Geometrie) und keins oder mehrere nicht-
rdumliche Attribute (non-spatial attributs, Fachdaten, Sachdaten) z.B. Stralenname, Eigentimer,

Baumhdhe.

e Eine Gruppe von rdumlichen Elementen, die zusammen eine Einheit der realen Welt représentieren.
Oft synonym verwendet mit dem Ausdruck Objekt. Kann auch zu komplexen Features (Objekten),
bestehend aus mehr als einer Gruppe von rdumlichen Elementen, zusammengesetzt werden.
(Lexikon der Geoinformatik, 2001)

e A geographic feature is ,an abstraction of a real world phenomeon ... associated with a location

relative to Earth®. A feature has spatial attributes (polygons, points, etc.) and non-spatial attributes
(strings, dates, numbers). (JUMP Workbench User's Guide, 2004)
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GeometryCollection: Zusammenfassung von mehreren Features auf einem Layer zu einem Feature.
GISWiki: Ein Wiki mit der Thematik "Geografische Informationssysteme (GIS)" ; http://www.giswiki.de/
GML: Geography Mark-Up Language; siehe auch http://www.opengeospatial.org/

GNU General Public License: Lizenzierung freier Software; http://www.fsf.org/licensing/licenses/gpl.html

Inkscape: Editor fur Vektorgrafik (Open Source); http://www.inkscape.org/

Item: Grafische Darstellung eines Features in OpenJUMP.

JPEG: Joint Photographic Experts Group; Grafikformat; http://www.jpeg.org/

JUMP: Unified Mapping Platform; Geografisches Informationssystem; http://www.jump-project.org/

Mapserver: Entwicklungsumgebung fir die Erstellung von Internet-Anwendungen mit dynamischen

Karteninhalten; http://mapserver.gis.umn.edu/
OGC: Open Geospatial Consortium; http://www.opengeospatial.org/
Internationales Normierungsgremium fur Standards und Schnittstellen von GIS und Location Based Services

(LBS) Anwendungen. Vereinigung von Firmen und Forschungseinrichtungen.

OGP: Oil & Gas Producer; http://www.ogp.org.uk/

OGP Surveying and Positioning Committee: ehemals EPSG, http://www.epsqg.org/

OpenGIS: siehe OGC; http://www.opengeospatial.org/

OpenJUMP: Geografisches Informationssystem; Erweiterung von JUMP;
http://openjump.org/wiki/show/HomePage

Open Source: Quelloffenheit; http:/de.wikipedia.org/wiki/Open_source

PNG: Portable Network Graphics; Grafikformat zur verlustfreien Speicherung

PostGIS: Erweiterung von PostgreSQL um geografische Objekte; http://postais.refractions.net/

PostgreSQL.: Objektrelationales Datenbankmanagementsystem; http://www.postgresql.org/
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Refractions Research: Kanadische Firma, die JUMP mitentwickelt hat; http://www.refractions.net/

Spatial attributes: Raumliche Attribute (Punkt, Linie, Fl&che).

Spatial information: Geoinformation, Rauminformation

SRID: Spatial Reference System Identifier; Kennung fur Rdumliches Bezugssystem

SRS: Spatial Reference System: Raumliches Bezugssystem

SVG: Scaleable Vector Graphics; vom W3C empfohlenes Grafikformat; http://www.w3.org/Graphics/SVG/

URL.: Uniform Resource Locator; z.B. ein Link im Browser.

Vertex, vertices: Knoten, Eckpunkt.

Vivid Solutions: Kanadische Firma, die JUMP mitentwickelt hat; http://www.vividsolutions.com/

W3C: World Wide Web Consortium; http://www.w3.org/

Well-Known Binary (WKB): Bindre Reprasentationen fir Geometrien, die in dem OpenGIS Dokument
,0penGIS Simple Features Specification For SQL“ definiert sind.

Wiki: Ein Wiki, auch WikiWiki und WikiWeb genannt, ist eine im World Wide Web verflgbare

Seitensammlung, die von den Benutzern nicht nur gelesen, sondern auch online geandert werden kann.

Wikis ahneln damit Content Management Systemen. Der Name stammt von wikiwiki, dem hawaiianischen
Wort fir "schnell". (Wikipedia, 2005)
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Well-Known Text (WKT): Textliche Darstellung von Geometrien, die in dem OpenGIS Dokument

,0penGIS Simple Features Specification For SQL" definiert sind.
Ein Punkt (Point) wird z.B. als 'POINT (10 15)' dargestellt.

Geometry Type SQL Text Literal Representation Comment

Point ‘POINT (10 10)° a Point

LineString ‘LINESTRING ( 10 10, 20 20, 30 40)° a LineString with 3 points

Polygon ‘POLYGON ((10 10, 10 20, 20 20, a Polygon with 1 exterior
20 15, 10 10))" ring and 0 interior rings

Multipoint ‘MULTIPOINT (10 10, 20 20)’ aMultiPoint with 2 point

MultiLineString ‘MULTILINESTRING ((10 10, 20 20), aMultiLineString with
(15 15, 30 15))’ 2 linestrings

MultiPolygon ‘MULTIPOLYGON ( a MultiPolygon with 2
((10 10, 10 20, 20 20, 20 15, 10 10)), polygons
((60 60, 70 70, 80 60, 60 60 ) ))'

GeomCollection ‘GEOMETRYCOLLECTION (POINT (10 10), a GeometryCollection
POINT (30 30), consisting of 2 Point values
LINESTRING (15 15, 20 20))’ and a LineString value

Geometrietypen im WKT-Format (Quelle: OpenGIS Simple Features Specification for SQL)

WKB: siehe Well-Known Binary

WKT: siehe Well-Known Text

WMS: Web Map Service; Internet-Dienst, der auf standardisierte Anfragen standardisierte Daten zur
Kartenbild-Darstellung liefert. Dieser Dienst ist als OGC Standard definiert.
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